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SAFETY PRECAUTIONS

(Read these precautions before using this product.)

Before using this product, please read this manual carefully and pay full attention to safety to handle the product correctly. If
the equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be
impaired.

The precautions given in this manual are concerned with this product only.

In this manual, the safety precautions are classified into two levels: "AWARNING" and "ACAUTION“.

Indicates that incorrect handling may cause hazardous conditions, resulting in

A WARN I N G death or severe injury.

C CAUTION Indicates that incorrect handling may cause hazardous conditions, resulting in
minor or moderate injury or property damage.

Under some circumstances, failure to observe the precautions given under "ACAUTION" may lead to serious
consequences.

Observe the precautions of both levels because they are important for personal and system safety.

Make sure that the end users read this manual and then keep the manual in a safe place for future reference.

[Security Precautions]

/\ WARNING

@® To maintain the security (confidentiality, integrity, and availability) of the programmable controller and
the system against unauthorized access, denial-of-service (DoS) attacks, computer viruses, and other
cyberattacks from external devices via the network, take appropriate measures such as firewalls,
virtual private networks (VPNs), and antivirus solutions.




CONDITIONS OF USE FOR THE PRODUCT

(1) MELSEC programmable controller ("the PRODUCT") shall be used in conditions;

i) where any problem, fault or failure occurring in the PRODUCT, if any, shall not lead to any major or serious accident;

and

ii) where the backup and fail-safe function are systematically or automatically provided outside of the PRODUCT for the

case of any problem, fault or failure occurring in the PRODUCT.

(2) The PRODUCT has been designed and manufactured for the purpose of being used in general industries.

MITSUBISHI ELECTRIC SHALL HAVE NO RESPONSIBILITY OR LIABILITY (INCLUDING, BUT NOT LIMITED TO

ANY AND ALL RESPONSIBILITY OR LIABILITY BASED ON CONTRACT, WARRANTY, TORT, PRODUCT

LIABILITY) FOR ANY INJURY OR DEATH TO PERSONS OR LOSS OR DAMAGE TO PROPERTY CAUSED BY the

PRODUCT THAT ARE OPERATED OR USED IN APPLICATION NOT INTENDED OR EXCLUDED BY

INSTRUCTIONS, PRECAUTIONS, OR WARNING CONTAINED IN MITSUBISHI ELECTRIC USER'S, INSTRUCTION

AND/OR SAFETY MANUALS, TECHNICAL BULLETINS AND GUIDELINES FOR the PRODUCT.

("Prohibited Application")

Prohibited Applications include, but not limited to, the use of the PRODUCT in;

» Nuclear Power Plants and any other power plants operated by Power companies, and/or any other cases in which the
public could be affected if any problem or fault occurs in the PRODUCT.

» Railway companies or Public service purposes, and/or any other cases in which establishment of a special quality
assurance system is required by the Purchaser or End User.

« Aircraft or Aerospace, Medical applications, Train equipment, transport equipment such as Elevator and Escalator,
Incineration and Fuel devices, Vehicles, Manned transportation, Equipment for Recreation and Amusement, and
Safety devices, handling of Nuclear or Hazardous Materials or Chemicals, Mining and Drilling, and/or other
applications where there is a significant risk of injury to the public or property.

Notwithstanding the above restrictions, Mitsubishi Electric may in its sole discretion, authorize use of the PRODUCT in

one or more of the Prohibited Applications, provided that the usage of the PRODUCT is limited only for the specific

applications agreed to by Mitsubishi Electric and provided further that no special quality assurance or fail-safe,
redundant or other safety features which exceed the general specifications of the PRODUCTSs are required. For details,
please contact the Mitsubishi Electric representative in your region.

(3) Mitsubishi Electric shall have no responsibility or liability for any problems involving programmable controller trouble and
system trouble caused by DoS attacks, unauthorized access, computer viruses, and other cyberattacks.



INTRODUCTION

Thank you for purchasing the FA integrated engineering software MELSOFT.
This manual describes the programming and functions required when using iQ AppPortal.
Before using this product, please read this manual carefully, and develop familiarity with the functions and performance of iQ

AppPortal to handle the product correctly.
Note that the menu names and operating procedures may differ depending on an operating system in use and its version.

When reading this manual, replace the names and procedures with the applicable ones as necessary.
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RELEVANT MANUALS

Manual name [manual number]

Description

Available form

iQ AppPortal Operating Manual
[SH-081623ENG] (this manual)

Functions and operation methods of iQ AppPortal

e-Manual
PDF

Poin tp

e-Manual refers to the Mitsubishi Electric FA electronic book manuals that can be browsed using a dedicated

tool.

e-Manual has the following features:

* Required information can be cross-searched in multiple manuals.

» Other manuals can be accessed from the links in the manual.

» Hardware specifications of each part can be found from the product figures.

» Pages that users often browse can be bookmarked.

« Sample programs can be copied to an engineering tool.




1 BEFORE USING THIS PRODUCT

iQ AppPortal is an integrated management tool for managing applications.

Assets such as project files of MELSOFT products and design documents that are managed in Windows® Explorer can be
saved for each application, and centrally managed in iQ AppPortal.

This can reduce person-hours for search and management.

1.1  System Overview

Assets (such as project files of MELSOFT products and design documents) registered and managed in iQ AppPortal are
referred to as objects.

For using the system of iQ AppPortal, two personal computers are required: one as a server for saving master data (DB) of
objects and the other as a client for operating objects in the screen of iQ AppPortal.

One personal computer can be used as both a server and a client.

Server Client

1 BEFORE USING THIS PRODUCT
1.1 System Overview 7



1.2 Features of iQ AppPortal

This section shows the features of iQ AppPortal for managing registered objects efficiently.
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Simple registration

Objects can easily be registered in iQ AppPortal by dragging and dropping folders and files.

A folder for each application is automatically generated when registering a new object. Name the folder to manage.
Folders and files are saved to a server after registered in iQ AppPortal, then the history can be managed and data can be

acquired.

Management for each application
In iQ AppPortal, folders are displayed for each application and objects in a folder are displayed in a layer structure.
The parent-child relationships of workspace files and project files of MELSOFT products are automatically determined by iQ

AppPortal, and the files are displayed accordingly.
Information on folders and objects managed in iQ AppPortal can easily be checked in the feature information displayed in the

callout property.
In addition, property information of folders and objects can be edited in the callout property and "Properties” screen.

Images can also be added to the property information.

1 BEFORE USING THIS PRODUCT
1.2 Features of iQ AppPortal



Quick search

Target folders and objects can easily be searched for by refining them under the smart filter (type, register date, and date
modified).

In addition, they can be searched for more quickly by using keywords for the property information and colored and named
classifications.

Secure editing/saving of objects

In iQ AppPortal, the latest data of an object saved to a server can be edited securely by acquiring it in a work area separated

from the save location.

Save the object to the server again after editing it in the work area.

The edit/management status of an object can be checked with the status displayed on it. (==~ Page 29 Status display of an
object)

Utilization of past data

When saving an added, edited, or deleted object to a server, the history is also saved.

From the history, the property information of the object can be browsed and past data can be acquired.

1 BEFORE USING THIS PRODUCT
1.2 Features of iQ AppPortal 9



1.3

Object List

This section shows the objects that can be managed in iQ AppPortal.

Name in the manual Icon Description File format Extension
Workspace file of MELSOFT products MELSOFT Navigator workspace file — *.nvw
Compressed single file | *.nvz
format
Project file of MELSOFT products E GX Works3 project file — *.gx3
GX Works2 project file — *.gd2
E Single file format *.gXw
Compressed file *.gwz
format
ﬁ GX Developer project file — *.9pj
MT Developer2 project file (iQ-R series) — *.mtw
u MT Developer2 project file (Q series) — *.mt2
Single file format *.mtw
Compressed file *.mtz
format
GT Designer3 (GOT2000) project file — *.gt32
Eﬁ Single file format *.gtx
Single file format *.gtxs
(including a GOT
operating system)
GT Designer3 (GOT1000) project file — *.gt3
Single file format *.gtw

RT ToolBox3 workspace file™

MELFA_WSP.xm
12

RT ToolBox2 workspace file™

MELFA_WSP.xm
12

i B

Simple Motion Module Setting project file — *.pmc
i-" Single file format *.pcw
— CW Configurator project file Single file format *.cp5
A |
W
MR Configurator2 project file — *.mr2
c | | Single file format *.mrc2
MR Configurator2 multiple axes system Single file format *.mrc2m
configuration project file
FR Configurator2 project file Single file format * frc2
FR Configurator2 (Developer) project file Single file format * fgw
4
'_

1 BEFORE USING THIS PRODUCT
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Name in the manual Icon Description File format Extension
Objects other than those of MELSOFT Differs for | Other files FB libraries — *.msim
products*3 each *.mslu
extension. *.usl
(Example) *.sul
: Files other than the — *.pdf
above *xls
*.doc
) etc.
Igap
Folder format object Folder containing other — —
I:F'\—\ files registered as an
=1 object.
For details, refer to the
following:
=" Page 79 Folder
format object
*1 Managed together in each workspace.
*2 Used to determine an object.
*3 An extension name is displayed on each icon.
The icon color can be set for each extension. (I==~ Page 50 Setting the icon colors of objects)
1 BEFORE USING THIS PRODUCT 1 1
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1.4 Learning Operation Methods of iQ AppPortal

This section explains the operation methods of iQ AppPortal.

Displaying the manual

Browse the manual to learn about operations and functions.

Operating procedure

Select the [Home] tab = the [Help] group = [Manual].
e-Manual Viewer starts and the manual appears.

Connecting to MITSUBISHI ELECTRIC FA Global Website

Open the MITSUBISHI ELECTRIC FA Global Website in a web browser.
Make sure your personal computer connect to the Internet in advance.

Operating procedure
Select the [Home] tab = the [Help] group = [Connect to MITSUBISHI ELECTRIC FA Global Website].

Checking the version of iQ AppPortal

Display information such as the software version of iQ AppPortal.

Operating procedure

Select the [Home] tab = the [Help] group = [Version Information].

1 2 1 BEFORE USING THIS PRODUCT
1.4 Learning Operation Methods of iQ AppPortal



2 SYSTEM CONFIGURATION

This chapter explains the system configuration of iQ AppPortal.
Folders and objects can be saved to a server in the screen of iQ AppPortal installed on a client.

For editing an object, acquire it from the server to a work area in the client and edit it in the work area. Then, save the edited
object to the server again in the screen of iQ AppPortal, and the data in the server is updated.

oo g

(©)

==

System configuration Role

1) Server « To store master data.
« To save past data and manage histories.

(2) Client « To select a server to connect to.
« To display information on objects saved to a server and those acquired in a work area on iQ AppPortal.
« To manage differences between an object in a work area and the corresponding one in a server.

3) Work area « To acquire data from a server and edit it.

2 SYSTEM CONFIGURATION
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3 SCREEN CONFIGURATION AND BASIC
OPERATIONS

This chapter explains the screen configuration and basic operations of iQ AppPortal.

3.1 startand End

This section explains the operation methods for starting and ending iQ AppPortal.

Start

Operating procedure

Start iQ AppPortal from "MELSOFT" in Windows Start.

End

Operating procedure
Select the [File] tab = [End].

3.2 Display Language Switching

iQ AppPortal supports multiple languages, and therefore the display language such as one on the menu can be switched on a

personal computer.

Window
Select the [File] tab = [Switch Display Language].

Display Language(L)

| English [~

'0\ It will be valid from next start.

I oK ] | Cancel

Precautions

If the display language differs from the one for the operating system, displayed texts may get cut.
The language of feature information of MELSOFT products and entered characters cannot be switched.

3 SCREEN CONFIGURATION AND BASIC OPERATIONS 1
3.1 Start and End 5



3.3 Data Storage Destination/Work Area Setting

This section shows the "Data Storage Destination/Work Area Setting" screen for setting a data storage destination in a server

and a work area in a client.

Window
Select the [File] tab = [Data Storage Destination/Work Area Setting].

Data Storage Destination/Work Area Setting

Please change the port No. only when you want to specify the port No. connected to the server.
Please execute "Add Connection Informatien” when you want to create new connection infermation of data storage
destination.
Please execute "Connect” after selecting data storage destination which you want to connect by Radic button of Connection
Information List.
Connection Information List (1)
Server IP address Port No. Repus\'t:ry Work Area | Add Connection Information(N) |
o] |122.004 61687 AP B casampleioaR -] || Delete Connection Information(y) |
@ B 127.00.1 61687 i0AP1 CAIOAPT [ (1)
3 127001 61687 iQAP2 || CARepasitories\iaaP2 (]
4 O 61687 i0AP [=]
Do not display this dialog again at start(D)
This setting can be changed in the option setting dialog.
Comnect || Concel
Item Description
Server IP address The IP address of a data storage destination (MELSOFT iQ AppPortal (Server))
Port No. A port number used for VisualSVN Server 5.0.3 (I==~ Page 75 Server specifications for using iQ AppPortal)
Repository A data storage destination. It can be named to identify multiple repositories.

When installing iQ AppPortal, the default repository (iQAP) is generated as a data storage destination.
To add a repository, run the installer on a server. ([~ Page 17 Adding a repository)

Work Area Alocal folder for editing data acquired from a repository

Point}@

Connection information (1) must be set so that a data storage destination (server IP address, port number,
and repository) and a work area are on a 1:1 basis.

Operating procedure

BAdding connection information and establishing a connection
1. Clickthe [Add Connection Information] button.
Arow is added in "Connection Information List."

2. Set each item for "Server IP address," "Port No.," "Repository," and "Work Area."

3. Select the radio button (2), and click the [Connect] button.
The connection is established to a data storage destination containing the specified connection information.

HDeleting connection information

1. Clickthe [Delete Connection Information] button.

Connection information is deleted.

However, the data in the repository is not deleted.

When deleting the connection information of a connected data storage destination, a new connection is established to the
destination containing connection information in the first row.

1 6 3 SCREEN CONFIGURATION AND BASIC OPERATIONS
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Adding a repository

A repository can be added by running the installer on a server after installing iQ AppPortal.

Point}”

» Up to 100 repositories can be created.

» Data registered in iQ AppPortal with version earlier than Version 1.11M is stored in the repository (iQAP)
generated when installing iQ AppPortal.

» When adding a repository, also create a corresponding work area.

» Before adding or deleting a repository, make sure that another client is not connected to a server.

Operating procedure

1. Ona server, double-click "setup.exe" in the installation DVD or data downloaded for installation.
Follow the on-screen instructions to add a repository.

MELSOFTiQ AppPorta! - Inst

MELSOFT iQ AppPortal - InstallSh

Add data storage destination (MELSOFT i@l AppPoral{Server]) repository

P

nstallSield [ oo J[ mew> | | oonea | Install5eld | <ok [ mew> | | conea |

The added repository can be selected in the "Data Storage Destination/Work Area Setting" screen.

2. Select the repository in the "Repository Setting" screen.

The repository of data storage destination is set.
Please select repository which you want to connect to.

" Repository is the name that identifies the data storage destination.
The repository can be added to installer. Please start the installer in the
server where you want to add repository.

" Registered repository is "iQAP" when MELSOFT iQ AppPortal(Server) is
installed.

Repository(E)

QAP =
| i0AP |
iQAP1
iQAP2

3 SCREEN CONFIGURATION AND BASIC OPERATIONS 1
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3.4 Option Setting

This section shows the "Option" screen for setting options such as "Basic Setting" for iQ AppPortal.

Window
Select the [File] tab = [Option].

Basic Setting .

User Setting
Object 1

User Name(U): USER

Object 2
Register Message
Verity [] Display the setting dialog of Data Storage Destination/Work Area at start(D)
Restore Work Area

oK | [ cancet ]

Basic setting

User setting

A user name set under "User Setting" is displayed in the "Comment Input" screen when saving, and in "Comment" or "Author"
in the "History" screen. (=~ Page 26 Saving an object)([==~ Page 52 History Management)

Object 1

Object filtering

EDisplaying deleted objects
Deleted folders and objects can be displayed on iQ AppPortal by selecting the checkbox of "Display the deleted object" under

"Object Filtering." (==~ Page 56 Deleted object acquisition)

EHiding read-only attribute folders
Read-only attribute folders can be hidden by unselecting the checkbox of "Display the read-only attribute folder." (=5~ Page

84 Hiding read-only attribute folders)

Classification option

EDisplaying the names of classifications added to objects (at the time of list display)
The names of classifications added to folders and objects can be displayed in the object list area by selecting the checkbox of

"Display the name of classification added to object. (At the time of list display)." (I~ Page 41 Classification name display)

Callout property option

BEnabling editing the callout property
Property information can be edited in the callout property by selecting the checkbox of "Enable Editing of Callout Property."

(==~ Page 30 Editing in the callout property)

Cache setting

Objects can be displayed in the screen more quickly by enabling the cache setting. (I~ Page 49 Increasing the display
speed in the object list area)

3 SCREEN CONFIGURATION AND BASIC OPERATIONS
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Object 2

Object icon display setting

The icon color of an object other than one of MELSOFT products can be set for each extension. (I~ Page 50 Setting the icon

colors of objects)

Register

Folder format object setting
Afolder can be registered as a folder format object in iQ AppPortal by selecting "Maintain Folder Configuration and Register it
as Folder Format Object." (I~ Page 79 Folder format object)

Verify

External tool setting
A tool used to verify an object other than one of MELSOFT products can be set. (I~ Page 87 Setting an external tool used

for verification)

Restore work area

If an error such as 'failed to restore work area' occurs while operating iQ AppPortal, a work area must be restored in "Restore

Work Area." (==~ Page 48 Restoring a work area)

3 SCREEN CONFIGURATION AND BASIC OPERATIONS 1
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3.5

Screen Configuration

This section explains the screen configuration of iQ AppPortal.

e —©
Cop & Solve the Data Conflict C <) [ Properties 1 [
Paste G-% M Cancel the Change Yo History R?( L= e
% Delete Reservation | |t 5 ey Dsa e )
>
1) — B
ST ServoSolution
jon1-1 ion1-2 I;:l : vusutmnjrj
Date Modified: Date Modified:
2023/10/06 2023/10/06
% GX Works3 Sample Data
i Vol11_Cart_PLC
8)
Mar:zucal:rbEEGDS—?ZLa
(C)]
2 - Lesfie
L f\‘ﬂ;mﬁa =
% WS _tmp17
+i
4
Pr1.58
"
@)
‘. Prjd_M25
+‘ (10)
“4)
#] Pr3_m24
K"
() ' -
Name Description
(1) Data storage destination/work area | A server IP address and root set in the "Data Storage Destination/Work Area Page 16 Data Storage
setting area Setting" screen are displayed. Destination/Work Area
. : The server IP address and repository of a data storage destination Setting
. g: The root of a work area
(2) Smart filter area Folders and objects can be refined by selecting an item under "Type" or a period | Page 32 Object Search
under "Register Date" or "Date Modified."
3) Classification area Folders and objects can be searched for by selecting a classification. Page 35 Searching by a
Classifications are displayed for each classification type. classification
(4) Free search box (classification) Classifications can be searched for by entering a keyword. Page 36 Classification search
(5) Object list area Folders and objects are tiled or listed. —
The display format can be changed by the following operation:
- Select the [Home] tab = the [Display] group = TieDisplay * o [UistDisplay - "1
from the pull-down list.
In addition, folders and objects detected by searching for or refining are
displayed.
If they are neither registered nor detected by searching for or refining, "No Data
Exists" is displayed.
(6) Sort group The order of folders and objects displayed in the object list area can be —
selected.
o Name ~ [ nate Modified ~ : Select an order.
- 2l Select this to sort folders and objects in ascending order according to the
selected item "Name" or "Date Modified."
« 2T: Select this to sort folders and objects in descending order according to the
selected item "Name" or "Date Modified."
(7) Free search box (folder/object) Folders and objects can be searched for by entering a keyword. Page 34 Searching by a
keyword
(8) Folder Objects for each application are included. —
9) Callout property The property information (model name, outline, image, etc.) of a folder and Page 30 Editing in the callout

object is displayed.

If a MELSOFT iQ AppPortal information file (.iqap) is saved to a server, the
feature information of a workspace file and project file of MELSOFT products is
also displayed.

Property information can also be edited in the callout property.

property

20
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Name Description

(10) | Application tree area Objects in a selected folder are displayed in a tree format. —
The parent-child relationship of objects is automatically determined and the
objects are displayed in a layer structure accordingly.

*1  When selecting [tstoissy -, the names of classifications added to folders and objects can be displayed. (==~ Page 41 Classification name
display)

3 SCREEN CONFIGURATION AND BASIC OPERATIONS 21
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3.6

Menu List

This section shows the menu list.

[File] tab

= [New] (Ij')

Page 23 New registration

= [Data Storage Destination/Work Area Setting] (&)

Page 16 Data Storage Destination/Work Area Setting

= [Switch Display Language] (fﬁ)

Page 15 Display Language Switching

< [Option] (F—])

Page 18 Option Setting

= [End] (E4) Page 15 Start and End
[Home] tab
= [Edit] group ( #) = [Copy] (L[7) —

= [Paste] (E) —

= [Delete Reservation] (><)

Page 27 Deleting an object

= [Work Area] group (Q)

= [Get the Latest Data] (£.])

Page 42 Acquiring the latest data of an object in a work
area

= [Solve the Data Conflict] (@;)

Page 45 Solving an object conflict

= [Cancel the Change] (")

Page 47 Canceling a change

= [Configuration Management]

group (*13)

= [Create Branch] (rl.%)

Page 57 Creating a branch

= [Revision Graph] ()

= [Revision Graph [Selected Folder]] ()

Page 58 Displaying a revision graph

= [Classification] group (=F)

= [Classification Edit] (5#)

Page 37 Classification edit

= [Sort] group (lﬁ)

= Pull-down list (Name * | Date Modified - )

= [Ascending order] (gl)

Descending order] (%T)

Page 20 Screen Configuration

= [Display] group (@5‘3)

Page 28 Updating the display status

= |
= [Refresh] (4.¥)
= [Properties] (L§)

Page 31 Editing in the properties screen

= [History] (@)

Page 52 History Management

= Pull-down list (me Display v / List Display -)

Page 20 Screen Configuration

= [Release Refine] (ﬁ)

Page 41 Releasing refinement

= [Verify] group ([4])

= [Verify between Objects] ()

Page 64 Verifying two objects

= [Verify with the Latest Data] (¥])

Page 66 Verifying with the latest data

= [Data Operation] group (%)

= [Import] (:F:l")

Page 69 Importing objects

o [Export] (G,

Page 71 Exporting objects

= [Help] group (@)

= [Manual] (El)

Page 12 Displaying the manual

= [Connect to MITSUBISHI ELECTRIC FA Global Website]
&)

Page 12 Connecting to MITSUBISHI ELECTRIC FA Global
Website

= [Version Information] (@)

Page 12 Checking the version of iQ AppPortal

3 SCREEN CONFIGURATION AND BASIC OPERATIONS

3.6 Menu List



4 OBJECT MANAGEMENT

This chapter explains the methods for managing objects by using iQ AppPortal.

4.1 Object Registration/Save/Deletion

This section explains the basic operations of iQ AppPortal such as registering, saving, and deleting an object.

Registering an object

In iQ AppPortal, an object is managed in a folder for each application.
When registering an object, a folder for each application is created in the object list area.

New registration

An object can be registered by dragging and dropping a folder or file onto the object list area.

The parent-child relationship of files in a folder is automatically determined by iQ AppPortal and the files are displayed in a
layer structure accordingly.

There are two selectable methods for registering a folder. For details, refer to the following:

[=5~ Page 79 Folder format object

X

>

T Project]

+

_-_a GX Works3Project
+

—— e = = .

‘a%/

Project1

So oo 0
m

7’

v

Operating procedure
1. Drag and drop a folder or file onto the object list area.

2. Enter a folder name.

Restriction@
« If multiple folders or files with the same name are included in the same layer in a folder, the folder cannot be

registered. In this case, register it as a folder format object. (==~ Page 79 Folder format object)
« Hidden files and folders included in a folder are also registered at the same time.

Point )’

» Folders and objects registered in iQ AppPortal are saved to a server by clicking the [Save] button, and
copied to a work area at the same time. ([~ Page 26 Saving an object)

» Up to 200 objects can be registered in one folder, and up to 10,000 folders and objects can be saved to a
server in total.
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HEWhen registering a workspace or project that consists of multiple files
It can be registered in iQ AppPortal by compressing it into a single file format (.zip, etc.).

Workspaces and projects other than the following ones must be compressed into a single file format (.zip, etc.).

BWorkspace file (workspace format)

* MELSOFT Navigator

* RT ToolBox3

* RT ToolBox2

WProject file (workspace format)

* GX Works3

* GX Works2

* GX Developer

* MT Developer2

* GT Designer3

« Simple Motion Module Setting

* MR Configurator2
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Additional registration/update

An additional object can be registered by dragging and dropping a folder or file onto a folder in the object list area or onto the
application tree area.

If the name and type of a dragged and dropped file are the same as those of a registered object and the file and object are
determined to be in the same layer by iQ AppPortal, the object is updated.

There are two selectable methods for registering a folder. For details, refer to the following:

[=5~ Page 79 Folder format object

/_§ | _-_a X Works3Project
) 9,

WS_tmp17

|
2% A

1: HIFLER New Project

Sample.gx3

.

EWhen dragging and dropping a file onto a folder in the object list area
An object is added to the folder.

If the object is a workspace file or project file of MELSOFT products, it is automatically displayed in a layer determined by iQ
AppPortal.

EWhen dragging and dropping a file onto the application tree area
An object can be freely added to any layer in the application tree area.

However, rules such as a layer placement relationship and parent-child relationship apply to the object. (I~ Page 78 Object
configuration rules)

When re-registering a workspace file or project file edited in a MELSOFT product, a message appears if the
update date and time is different between the MELSOFT iQ AppPortal information file (.iqap) and the
workspace file or project file.

If the message appears, save the workspace file or project file again in a MELSOFT product that supports
MELSOFT iQ AppPortal information files (.iqap), then re-register it.

Precautions

« If a project file is moved from the workspace tree of MELSOFT Navigator in the application tree area, it is deleted from the
workspace managed in MELSOFT Navigator.

» When adding a project file to a workspace managed in MELSOFT Navigator in the application tree area, register it in a
workspace format. If registered in a single file format, it is not displayed in the workspace tree of MELSOFT Navigator.
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Saving an object

A folder and object registered in iQ AppPortal can be saved to a server by clicking the [Save] button.
A comment entered in the "Comment Input" screen is displayed in "Comment" in the "History" screen. (I~ Page 52 History

Management)
L | — m] Comment Input
Fil : -
L Grs T o T R T e s A e e e T GIE e
Y x Y displayed as the history dialog.
. - Exceeded string will be deleted when the string which exceeds its maximum one was
— pasted.
. (16/2000 characters)
. New Project ~
Project
Date Modified: [> add
2023/10/05
v
% GX Works3Praject < >
a
oK [ cancel

% Sample
+]

fy | readmeitxt
+

ate Modified:
2023/10/05

% GX Works3Project
[
-

% Sample

LT

e readme.txt
[

Operating procedure

1. Click the [Save] button in the application tree area.

2. Enter a comment.

Pointp

« For saving a folder and object in the application tree area, the following operation is also available:

- Right-click it and select [Save the Selected Object] from the shortcut menu.

» When saving multiple objects at the same time, there may be the following cases:

- A comment entered when saving them is displayed in "Comment" of all of them.

- If there is even one conflicting object in a folder, the objects cannot be saved. Solve the data conflict, then
save them again. (=5~ Page 45 Solving an object conflict)

» Up to 2,000 characters can be entered in a comment. A line feed is counted as two characters.

Precautions

Check that the overlay icon is G (Normal) after saving an object. If it is not Normal, the object is not saved properly. Save it
again after removing the cause. (==~ Page 29 Status display of an object)
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Deleting an object

Data saved to a server can be deleted.

When deleting data in a server, the corresponding folder or object acquired in a work area is also deleted at the same time.

File Home

[y Copy G Cr E? Name - G [ Properties &( [E4 Verify between Objects B% Import e
Paste == M Cancel [Ees| Re Al A History Verify with the Latest Data Export
- Get the ) ) Classifiation | 2+ 2T Refresh 2 Reewse | & S H,
Latest Data =] Res Edit Tile Display - | Refine i
kait (7\ Worl g assification Sort Display Verify Data Operation
L | X 4 — 0
File Home File Home i
i
=5 GX Works3 Sample Data ol GX Works3 Sample Data
i voll1_cart_r_a ) voll1_cart_r_a
GX Works3 Sample GX Works3 Sample _
Data ) Data
ified: Date Modified:
Date Mnd;fnlgvmms =E GX Works3 Sample Data : = e 2(‘1;1,’09f06
X Vol11_Cart_PLC
— (0
m 2 CSESSESEEstCcooos

’
D [} D
|
|
|
|
v ! v

GX Works3 Sample : Vol11_Cart_PLC  Vol11_Cart_PLC
Data1.iqap 1 .gx3 .gx3.iqap
\

GX Works3 Sample
Data1.iqap

/ \
] ]
] |
] ]
] |
] ]
] |
] |
1 1

———————————

Operating procedure

1. Select the [Home] tab = the [Edit] group = [Delete Reservation].
The overlay icon changes to x (Delete Reservation). (==~ Page 29 Status display of an object)

2. Click the [Save] button. (==~ Page 26 Saving an object)

Precautions

When deleting a folder and object, all objects in their lower layers are also deleted at the same time.
In addition, its property information is deleted at the same time.
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4.2

Object Information Edit

This section shows the details on editing object information registered in iQ AppPortal.

Updating the display status

The statuses of a folder and object displayed on iQ AppPortal can be updated as necessary after comparing data saved to a
server with an object acquired in a work area.

File Home
yCopy
Paste

M Delete Reservation

Get the
Latest Data

Tl ] &

Name - 0 |63 Properties ﬁ( [ Verify between Objects BSImport e
A O History [y Verify with the Latest Data Bl Bxport
z Refresh Release
i ~ Refine HED

4

File  Home

=l
5l ol
ServoSolution1-1 5 ion1-2
Date Modified: Date Modified:
2022/11/15 2022/11/15
= =
5] b
ServoSol 2 S ion2-1
Date Modified: Date Modified:
2022711415 2022/11/15

5 ServoSolutionT-1

B

volll_cart_r_a

(J GX Works3 Sample Data
(T Vel11_Cart_PLC

a Manual
pdf |
()

bcn-b62005-721_a

o Leaflet
df
Ia- 1031062

Operating procedure

Select the [Home] tab = the [Display] group = [Refresh].

Point}3

Base BaseProject ServoSolution1

If neither folder in the object list area nor object in the application tree area is selected, the displays of all
folders and objects are updated.
Even when an error occurs in a selected folder or object, the displays of all folders and objects other than the

selected one are updated.
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Status display of an object

The status of an object is displayed with an overlay icon.
The object status indicates the difference between data saved to a server and an object acquired in a work area.

Overlay icon Object status Status of an object

rf Conflict While editing an object in a work area, the corresponding data in a server is updated by another
ol user.

’ Change An object in a work area is newer than the corresponding data in a server.

X Delete Reservation Data in a server is reserved for deletion (not saved).

+ Add Data is added to a server, or a file is added to a work area (not saved).

E] Past Version Data An object in a work area is older than the corresponding data in a server.

(N/A) Not acquired No object is acquired in a work area.

@ Normal There is no difference between an object in a work area and the corresponding data in a server.

Restriction@
The overlay icon is not displayed on a read-only attribute folder because an object in the read-only attribute

folder cannot be edited.
For details on read-only attribute folders, refer to the following:
[Z=~ Page 83 Read-only attribute folders

HIf several object statuses exist in a folder
The object statuses of all objects in the folder are determined and the overlay icon of the folder is displayed accordingly.

Priority order 1 2 3 4 5 6 7
Object status Conflict Change Delete Add Past Version Not acquired Normal
Reservation Data

[Ex]

If several object statuses exist, the overlay icon of a folder is displayed as follows:

» The Conflict overlay icon is displayed on the folder if the folder contains a conflicting object.

» The Change overlay icon is displayed on the folder if the folder contains objects that are changed, reserved for deletion, or
added.

» The overlay icon is displayed in the order of Past Version Data, not acquired, and Normal if an object in the folder is past
version data, not acquired, or normal.

HIf several object statuses exist in objects in the parent-child relationship

The object status of the lower layer is also displayed on the object in the upper layer.

The object status displayed on an object in the upper layer is displayed in the same priority order as a folder.

However, if there is no change in an object in the upper layer when an object status in the lower layer changes, the edit history
of the object in the upper layer is not saved.

HIf an overlay icon is not updated
When caching is enabled, an overlay icon may not be updated. In this case, select the folder to update it.

To update all overlay icons, refresh the cache.
For details, refer to the following:
[=5~ Page 49 Increasing the display speed in the object list area

HIf a MELSOFT iQ AppPortal information file (.iqap) in a work area is old

o5 SAMPLE
'_Oj [ sample data

4
If a MELSOFT iQ AppPortal information file (.iqap) in a work area is older than the corresponding one in a server, the icon

indicating that the file is old is displayed.
To match the file between the work area and the server, acquire the latest data.
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Editing property information

Property information of folders and objects can be edited in the callout property and "Properties” screen.

Editing in the callout property

Window.

Select the [File] tab = [Option] = "Object 1."

Basic Setting
Object 1
Object 2
Register
Verify

Restore Work Area

Object Filtering
Display the deleted object(s)
Display the read-only attribute folder(R)

The option at output
[] Start the explorer at get the latest data(E)
Classification Option
Display the name of classification added to object. (At the time of list display) (Q)

Callout Property Option

[ Enable Editing of Callout Property(V) ]

It is possible to edit the name, madel name, outline, image, author, and remark.

The display item other than the name can be selected.

Display Item(D): Item Name

Date Madified
Model Name
Outline
Feature
Image
PP

>

Cache Setting
@) Enable CachelC)
© Disable Cache(t)

If cache setting is enabled, the screen can be displayed faster. But if enabled, the displayed
folder cannot be displayed in the latest state sometimes. The latest state can be displayed
by selecting the folder which the latest state want to be confirmed.

When refresh all the object cache, please execute "Cache Refresh®.

Cache Refresh

G

Operating procedure

L | - @

File Home

*ih

st

GX Works3 Sample GX Works3 Sample GX Works3 Sample

Data Data Data

Date Medified: Date Modified: Date Modified:
2022/11/14 202211714 202/11714

Save Cancel Properties

GX Works3 Sample Data
DEICYNLLIGEL I 2022/11/14 09:26:42
L% uCW Vol11_Cart_PLC

p S
WINLEN Application program example for Automated Guided Vehicle,
PLC CPU:RO4CPU,Simple Motion module:RD77MS4

Feature GX Works3 Ver... Program:1

Image

Classification

Classification Name#

Author
Register Date
Date Created

e

EICLETL N Vol 11_Cart_PLC.gx3.
remark [

1. Select the checkbox of "Enable Editing of Callout Property" under "Callout Property Option" in the "Option" screen.

2. Inthe "Display Item" list, select the checkboxes of items to display in the callout property, and click the [OK] button.
The items with their checkboxes selected are displayed in the callout property. ("Name" is always displayed.)

3. Enter property information in the callout property, and click the [Save] button.

Point}3

Restriction@

* The contents of "Name," "Model Name," "Outline," "Author," and "Remark" can be edited.
» An image file can be added to "Image." (<5~ Page 31 Image registration)
» A classification added to the object in the "Classification Edit" screen is displayed in "Classification."

(==~ Page 40 Classification addition)

Property information cannot be edited in the following cases:

» Aread-only attribute folder is selected.
» A deleted object is selected.

» An object is selected when its overlay icon is E (Conflict), x (Delete Reservation), or [ﬂ (Past Version

Data).

» The "Properties" screen of an object with its callout property displayed is open.
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Editing in the properties screen

Window.

Click the [Properties] button in the callout property.

Home

GX Works3 Sample GX Works3 Sample

Data L Data

Date Modified: [ Date Modified:
2019/09/13 3/12 2019/09/13

[LEEEREREN Vol 11_Cart PLC

(ST W Application program example for Automated Guided Vehicle.
PLC CPU:RO4CPU, Simple Motion module:RD7T7MS4

Feature | R16

GX Works3 Version 1.065T

GX Works3 Sample Data G

Vol11_Cart_PLC Program:1

-
Application program example for Automated Guided Vehicle. i - ?‘
PLC CPU:R04CPU,Simple Motion module:RD77MS4

Ri16 ‘ | GX Works3... | | Program:1 ]
5=

FB/FUN:3
Title

Comment

Classification 102
oL MITSUBISHI ELECTRIC CORPORATION
2016/02/26 11:10:15
2015/02/17 19:11:24
1,794,046 Byte

[ZICEL T Vol 11_Cart PLC.gx3

Remark

Operating procedure

Enter property information, and click the [Save] button.

Point/®

* The contents of "Name," "Model Name," "Outline," "Author," and "Remark" can be edited.

» An image file can be added to "Image." (I==~ Page 31 Image registration)

« A classification added to the object in the "Classification Edit" screen is displayed in "Classification."
(==~ Page 40 Classification addition)

Property information cannot be edited in the following cases:

» Aread-only attribute folder is selected.

» A deleted object is selected.

» An object is selected when its overlay icon is E (Conflict), X (Delete Reservation), or E] (Past Version
Data).

Image registration

An image can be registered in the property information of a folder and object.

The registered image is displayed in the callout property and in "Image" in the "Properties" screen.
Operating procedure

Click the [+] button at the bottom right of "Image" to select an image file.

HFile types and sizes which can be registered in "Image"
An image file (.bmp, .jpg, .jpeg, .gif, .tif, .tiff, .png, etc.) can be registered in "Image."
A size which can be registered is less than 5 MB per image file.
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4.3 Object Search

This section shows the details on quickly searching for folders and objects registered in iQ AppPortal by using the smart filter

area, free search box (folder/object), or classification area.

* In the smart filter area, folders and objects can be refined under "Type," "Register Date," or "Date Modified."

« In the free search box (folder/object), folders and objects can be searched for by entering a keyword included in their
property information.

* In the classification area, folders and objects with classifications added can be searched for.
Found folders and objects are displayed in the object list area.

Point
A condition specified for a search is retained even after ending iQ AppPortal.
When starting it next time, the object list area will be displayed with a condition specified for the previous
search retained.
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Refining under the smart filter

In the smart filter area, folders and objects can be refined by specifying an item under "Type" or a period under "Register
Date" or "Date Modified."

Point}3

4

File

R

Home

& simy o
NEISCE e a Y

r Date

4

The display in the smart filter area is updated by clicking the [Get the Latest Data] button in the application
tree area.

Aodule Setting

March 2020

Su Mo Tu We Th Fr

25 26 27 28 2
4 5 6 7
1 [ 12
12 19 20
25 26 27
12 03 4

RS2
A

4

2020-2029 r

2019 2020 2021 2022

2023 2024 2025 2026

2027 2028 2028 2030

SERE. o oo oo o000

Clear of select area

= ]
it
g (H |5 |2
! o) (]
Pri2_M23 Pri2_M24 Pri2_M25 Pri3_G3
Date Modified: Date Modified: Date Modified: Date Modified:
2016/06/08 2016/06/08 2016/06/08 2017/09/13
Gel &gl &el Sel
Pi3_G3 Pij3_G3 Prj3_G3 Pj3_G3
Date Modified: Date Modified: Date Modified: Date Modified:
2017/12/14 2017/12/14 201771214 2017712420
s
Voll_VFFS, Voll_VFFS_GOT Voll_VFFS_PLC Voll_VFFS_PLC
Date Date Medified: Date Modified: Date Modified:
2017/12/25 2017/12/25 2017/12/25
5
(] o)
Vol7_Safety_GOT Vol7_Safety_Motion Vol7_Safety_Moton Vol8_Eco_GOT
Date Modified: Date Modified: Date Modified: Date Modified:
2017/12/25 2017/12/25 2017/12/25 2017/12/25
Vol8_Eco PLC
Date Modified:
2017/12/25

<l

Operating procedure

+ Select the checkbox of the type of an object under "Type."
» Specify a period under "Register Date" or "Date Modified."
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Objects that can be refined by the type

The following shows the objects that can be refined by the type.

BMWorkspace file

* MELSOFT Navigator

WProject file

* GX Works3

* GX Works2

* GX Developer

* MT Developer2

« GT Designer3

* RT ToolBox3

* RT ToolBox2

« Simple Motion Module Setting

« CW Configurator

* MR Configurator2

» FR Configurator2

Searching by a keyword

Folders and objects can be searched for by entering a keyword included in their property information in the free search box
(folder/object).

9
ArtiEAITOY TS~
Date Modified: Date Modified: Date Modified:
2018/08/23 2018/01/17 2019/08/23
= = = =
() () ) 9
GX Works3 Sample GX Works3 Sample GX Works3 Sample GX Works3 Sample
Data Data Data Data
Date Modified: Date Modified: Date Modified: Date Modified:
2019/09/12 2019/09/13 2019/09/13 2020/02/02
M

For searching by a keyword, characters are case-sensitive.
When entering multiple keywords delimited by spaces, objects including the keywords can be searched for.

Operating procedure

Enter a keyword in the free search box (folder/object).
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Searching by a classification

In the classification area, folders and objects with classifications added can be searched for.

= [m]
i x
~
- u
o | - -
GX Works3 Project GX Works3 Sample LineA_EquipmentA LineA_EquipmentB
Smart Filter Date Modified: Data Date Modified: Date Modified:
2023/10/11 Date Modified: 2023/10/11 2023/10/11
(O EES55555555 2003/10/06
Classification A 2 e

Search Method

® AND O OR = = F% r.%
bl m bl - - -
Line ~ LineB_EquipmentA LineB_EquipmentB LineC_EquipmentA LineC_EquipmentB.
Date Modified: Date Medified: Date Medified: Date Modified:
2023/10/11 2023/10/11 202341011 2023/10/11

M 007.Line A
1 o0z,
[ 003.Line C

—_——— e — == T >

Equipment

B 101.Measurement equipment

= ————

Operating procedure
1. Select "AND" or "OR" in "Search Method" in the classification area.

2. Select the checkbox of a classification for a search.

Pointp

For searching for folders and objects in the classification area, the following operations must be performed in

advance:

« Create a colored and named classification in the "Classification Edit" screen. ([~ Page 37 Classification
edit)

* Assign a classification type to a classification in the "Classification Edit" screen. (==~ Page 37 Assigning a
classification type)

» Add a classification to a folder and object. ((=5~ Page 40 Classification addition)
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Classification search

Classifications can be searched for by entering a keyword in the free search box (classification).

Classification

Search Method

Equipment C

Function

(!
M M ProjectE

For searching by a keyword, characters are case-sensitive.
When entering multiple keywords delimited by spaces, classifications including the keywords can be searched for.

Operating procedure

Enter a keyword in the free search box (classification).

Search condition clearing

All search conditions for classifications can be cleared by clicking the - icon in the classification area.
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Classification edit

A classification can be edited (added/changed/deleted) in the "Classification Edit" screen.
In addition, a classification type can be assigned to a classification.

Up to 5000 classifications can be created.

Window.

Click the g icon in the classification area.

Classification Edit x Classification

To add classification or not in the currently selected item, please use the checkbox on the side of each classification. To edit the
classification, please select classification and edit it from the button on the right side.(C) Search Method

[Classification Type Setting(D | [ Classification Display Position Setting(P) |

MName Classification Type New ()

ompany A Customer -
2 [ companyB Customer - Company A
2 [ M equipment C Equipment - Color(L) .EI D B B Company B
4[] M Function D Function -
5 [ Project E Project -

‘When multiple new classifications from classification edit screen is given as a whole, which under the
classification list in the object list is priority displayed.

oK | [ cancel

Operating procedure

BAdding a classification
1. Click the [New] button.

2. Enter a classification name.

BEChanging a classification name
1. Perform either of the following operations:

» Double-click a classification name.
+ Select a classification to change its name, and click the [Rename] button.

2. Enter a classification name.

BChanging a classification color

1. Select a classification to change its color.

2. Select a color from the pull-down list of m[¥].

BAssigning a classification type
Select a classification type to assign from the pull-down list in the "Classification Type" column.

For the setting method of a classification type, refer to the following:
==~ Page 38 Classification type setting

ESetting the display position for each classification
In the "Classification Display Position Setting" screen, set the display position for each classification in the object list area and

application tree area.
For details, refer to the following:
[~ Page 39 Display position setting for each classification
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HDeleting a classification
1. Select a classification to delete.

2. Click the [Delete] button.

Classification type setting

A classification type can be set in the "Classification Type Setting" screen.

The set classification type can be assigned to a classification. ([~ Page 37 Assigning a classification type)
Up to four classification types can be set.

Window.

Click the [Classification Type Setting] button in the "Classification Edit" screen.

Classification Type Setting

No. Name

2 |[Equipment

3 [Function

4 [Project

ok | [ cancel

Operating procedure
1. Enter a classification type name.
2. Click the [OK] button.

The set classification type is applied to the "Classification Type" column in the "Classification Edit" screen.

Point}3

In the "Properties" screen, classifications are displayed in numerical order (No.1 to No.4) of the classification
types in the "Classification Type Setting" screen.

(Example) For the following combinations:

« Classification type No.1: Customer, Classification: Company A

» Classification type No.2: Equipment, Classification: Equipment B

» Classification type No.3: Function, Classification: Function C

« Classification type No.4: Project, Classification: Project D

Classification Edit x
To add classification or not in the currently selected item, please use the checkbox on the side of each
classification. To edit the classification, please select classification and edit it from the button on the right side.(C)
Classification Type Setting(D | Classification Display Position Setting(®) | Servosolution]
= A 2023/10/05 155853 ]
Name Classification Type New(M) LU
A Customer - Rename(R) v
2 [ Mctquipment Equipment - HelciclD) AW The AGV picks up a workpiece and ]
carries it to the target position.
3 [ MFunctionC Function - Colori) IE‘ geLp
4 [0 ProjectD Project \\ -
- Image
‘When multiple new c\as( \:awho\a
which under the classifi " ey
Classification Type Setting x
oK | [ cancel
2 [Fquipment
3 [Function
4 |roject
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Display position setting for each classification
The display position for each classification in the object list area, application tree area, and revision graph can be set in the

"Classification Display Position Setting" screen.
Set the display position of a classification for each classification type.

Window.

Click the [Classification Display Position Setting] button in the "Classification Edit" screen.

| = @

Please set the display pesition to change the display position of the celor comresponding to the classification. File ' Home
1 »
Display Position Description C!
Object List Area Display Application Tree Area Display, etc. 4
4 =5 ServoSolutiont
S R
L GX Works3 Sample Data
@) Vol11_Cart PLC
@ fest QWS v
Display Position Setting | Display Revision Details | | Create Branch
Display Position Classification Type to be Displayed
Revision No. /' 14 15 16 20 ¢
Customer ” B025/10/04Y 2023/10/04 | 2023/10/04 | 2023/10/04
2 Equipment v L 1 1 1
3 Function v
4 Project \\ v < [ >
- ~
= —
Mame Classification Type
% ompany A Customer -
2 M Equipment B Equipment -
3 Function C Function -
4 Project D Project -

Operating procedure

1. Seta classification type in the "Display Position Setting" field for each number displayed in the "Display Position
Description" field.
2. Click the [OK] button.

3. Click the [OK] button in the "Classification Edit" screen.
Classifications are displayed in the set display positions.
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Classification addition

A selected classification can be added to a folder and object.

Home

[FyCopy
Paste

ta Conflict | gy Create Branch

. ¥ [ Properties ﬁ( [ Veerify between Objects B Import e

= the Change Revision Graph OJHistory ¥ Verify with the Latest Data Export
Get the . = Refresh Release ) 8 Hel
3¢ Delete Reservation | | atest Data on Graph [Selected Folder] Tile Display | Refine =)
Edit Work Area onfiguration Management Sort Display Verify Data Operation

Classification Edit x

To add classification or not in the currently selected item, please use the checkbox on the side of each

classification. To edit the classification, please select classification and edit it from the button on the right side.(C)

Classification Type Setting(D) | | Classification Display Position Setting(£)
|":|E ServoSolution1 Name Classification Type Il Newl) |
®. voll1_cart_r_a - A Customer I Rename® |
2 | CJ|M company B Customer - Delete(D)
: 3 Equipment C Equipment - Colorl) El
C [ ] GX Works3 Sample Data
= o Voll1 Cart PLC 4 | CIfM Equipment D Equipment B
Search Method ‘ —ve s 5 Function E Function -
G oF 3 Function F Function -
_ sy Mznual 7 Project G Project -
Customer ServaSolution1-1 T be2005-721 =l
Date Modified: 1 L When muttiple new classifications from classification edit screen is given a5 3 whole,
2023/10/11 which under the classification list in the object list is priority displayed.
[ ok ] G ]
pdi | Leaflet
(. 103106a

Operating procedure

Hin the classification area
Select a classification, and drag and drop it onto a folder and object.

Hin the "Classification Edit" screen

1. Selecta folder and object, and select the [Home] tab = the [Classification] group = [Classification Edit].
The checkboxes of classifications are displayed in the "Classification Edit" screen.

2. Select the checkboxes of classifications, and click the [OK] button.

Pointp

Up to 20 classifications can be added to one folder or object.

Classification cancellation

An added classification can be canceled by unselecting the checkbox in the "Classification Edit" screen.
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Classification name display

The names of classifications added to folders and objects can be displayed when listing the folders and objects in the object
list area.

Window
Select the [File] tab => [Option] = "Object 1."

Basic Setting

Object Filtering
Object 1

[] Display the deleted object(S)

Object 2 Display the read-enly attribute folder(R)
Register The opticn at output
Verify [[] Start the explorer at get the latest data(E)
Restore Work Area

Classification Option

[ Display the name of classification added to object. (At the time of list display)(Q) ]

Callout Property Option %

[] Enable Editing of Callout Property(V)

ltis possible to edit the name, model name, outline, image, author, and remark. & ServoSolution1 Date Modified:
Company A 2022/11/15
The display item other than the name can be selected. . pany 022/11/15
I Equipment C
Display Hem®) [ e o I Function D
Date Modified [l
] Model Name EI
v| Qutline
| Feature
Y image -

Cache Setting

(@ Enable Cache(C)
(O Disable Cache(l)

If cache setting is enabled, the screen can be displayed faster. But if enabled, the displayed
folder cannot be displayed in the latest state sometimes. The latest state can be displayed
by selecting the folder which the latest state want to be confirmed.

When refresh all the object cache, please execute "Cache Refresh”.

Cache Refresh

oK | [ Concel |

Operating procedure

Select the checkbox of "Display the name of classification added to object. (At the time of list display),” and click the [OK]
button.

Releasing refinement

The display in the object list area and classification area can be returned to the state before searching.

Operating procedure

Select the [Home] tab = the [Display] group => [Release Refine].
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4.4 Object Utilization

This section shows the details on editing an object registered in iQ AppPortal by acquiring the corresponding data from a

server to a work area.
The edited object must be saved to the server after updating the display status in iQ AppPortal.

Acquiring the latest data of an object in a work area
The latest data of an object to be edited (including objects in its lower layer) can be acquired from a server to a work area.

Home

P4 Copy g Create Branch Name - 0 [ Properties ﬁ( [ Veerify between Objects B Import 9
Paste [Eez| Revision Graph A A1 OHiston, 7 Veerify with the Latest Data | & Export
. Classification | 2% Z Refresh Release Hel
3¢ Delete Reservation Revision Graph [Selected Folder] Edit Tile Display  +| Refine elp
Edit onfiguration Management Classification Sort Displa Data Operation

File Home
"
= il
ol Bl =5 ServoSolutio
ServoSolution1-1 ServaSalution1-2 ol whicrra
Date Modified: Date Modified:
2023/10/06 2023/10/02
EvI8 GX Works3 Sample Data
@ Vol11_Cart PLC
= == : j
SeNOSD‘ulI.OHZ ServoSo\ul\.or\Z-1 S ben-b62005-721_a
Date Medified: Date Modified:
2023/10/02 2023/10/02 Q Q Q
Leaflet
g 1031062 Base BaseProject ServoSolution1
v

A work area can be set in the "Data Storage Destination/Work Area Setting" screen. (=5~ Page 16 Data Storage Destination/
Work Area Setting)

Operating procedure

Click the [Get the Latest Data] button in the application tree area.

4 OBJECT MANAGEMENT
4.4 Object Utilization



Editing an object

An object acquired in a work area can be edited.

[ MELSOFT GX Works3 (Untitied Project) - [Module Configuration *] [E=EEx)

i Project Edt Find/Replace Convert View Online Debug Diagnostics Tool Window Help _sx
iDeAg|e ClignresgRn aaaansas A5 AL ea
Y T sl Vel T A A P AN S G E YR

PoUj

—E ServoSolution1

o

vol11_cart_r_a - 5% o X [

EE GX Works3 Sample Data
9 Vall1_Cart

£2

pPortal Installatic...

Refresh(E)
Get the Latest Data(l)
Verify(F)

Open the Place of Object{l) v
‘Open From Program(G) )

Copy(C)

Paste(P)

ol el

, JOFT iQ AppPortal...

FHAAGA 5 PX5F )

Delete Reservation(D)

(=]

Solve the Data Conflict{O)...

Classification Edit(M)...
History(H)...
Revision Graph(A)..

Revision Graph [Selected Folder](S)..

Properties(R)...

Operating procedure

To edit an object acquired in a work area, start a tool for editing in iQ AppPortal by either of the following operations:
+ Double-click an object.
* Right-click an object and select [Open From Program] from the shortcut menu.

Restriction@

If the overlay icon is E (Conflict) or == (Add), or no object is acquired, a tool for editing does not start.
In addition, it does not start if not installed on the operating system.

HIf a tool for editing does not start in iQ AppPortal

Edit an object by the following procedure:

1. Open the place of an object by either of the following operations:

* Right-click an object and select [Open the Place of Object] from the shortcut menu.
+ Click the root (JLH) in the data storage destination/work area setting area.

2. Start the tool for editing and edit the object.
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Saving an edited object again

An edited object must be saved to a server again.

File ' [ERea.

%= Solve the Data Conflict
ste ==\ Cancel the Change

: Get the
¢ Delete Reservation | |atest Data

ﬁ( [ Verify between Objects B& Import e
[ Verify with the Latest Data | B, Export
Release

~ | Refine He_lp

File ' Home
’ ik
- PR B o
: S| | <& ServoSolutionT-1 |
|| ServoSolution1-1 ServoSolution1-2 2] voimicartra |
|| Date Modified: Date Medified: )
i 20221115 2022/11/15 . .
1 Base BaseProject ServoSolution1
I 2718 GX Works3 Sample Data |1
! i Val11_Cart_PLC | \
. - || === -
5:' . 5:' . Manual
ServoSoIl_lt_lonZ Servo&oll_lt_lonz-l ) ben-b62005-721_2
Date Modified: Date Modified:
2022111115 20221115
i Leaflet
f
103106a
]

Operating procedure

1. Select the [Home] tab = the [Display] group = [Refresh]. (=5~ Page 28 Updating the display status)
The overlay icon changes to _J" (Change). (==~ Page 29 Status display of an object)

2. Click the [Save] button. (==~ Page 26 Saving an object)

» Even when changing a folder or file name in a work area, the corresponding folder or object saved to a
server is not updated. The changed one is registered as a new folder or object.

« To re-register a folder and file duplicated outside a work area in iQ AppPortal, drag and drop a folder for
each application onto iQ AppPortal.
For the folder configuration, refer to the following: (==~ Page 85 Folder configuration in a work area)

4 OBJECT MANAGEMENT
4.4 Object Utilization



Solving an object conflict

When saving an object edited in a work area to a server, its overlay icon changes to E (Conflict) if the corresponding data in
the server is updated by another user.
If the overlay icon is E (Conflict), the state must be solved.

'B g C ; Name - <) [ Properties ﬁ( T2 Verify between Objects B4 Import e

== " Cancel the Change Al A History Verify with the Latest Data Export
Get the % a2 — Relemse | D & v
Latest Data Tile Display - | Refine =P

File Home

i

IS _‘) _______ -

| == =

| B o

| Project1 Project2

| Date Madified: Date Modified:
1 2021/09/07 2021/08/07
1

1

\

Solve the Data Conflict x d — m]

It may be changed by work area to the data which is not the latest because the s
data of the data storage destination is updated by the other user. i
Please select how to solve. (1 )

| == <l

i\ o_l

| Project1 Project2

- Date Medified: Date Modified:
1

1

1

|

(Cannot overwrite and register the folder which has been registered in the
folder format object when it is moved or deleted by the other user)

®) Overwrite and register it with the object of work area
2021/09/07 2021/09/07

() Update the work area in the object of the data storage destination
(Discard the edit data of work area)

[ oK | [ cancel |

Solve the Data Conflict x 4

File Home

It may be changed by work area to the data which is not the latest because the

data of the data storage destination is updated by the other user. ’ i >
Please select how to solve. (2)
| =2
e o
O Overwrite and register it with the object of work area Project1 Project2
(Cannot overwrite and register the folder which has been registered in the Date Modified: Date Modified:

[}
[}
[}
) 2021/09/07 2021/08/07 || NS S=S=SSs=======
[}
[}
[}

g
| ==

[ oK [T e ] I STEEEEETT R

(1) Solving the conflict by overwriting the data in the data storage destination with the object in the work area
(2) Solving the conflict by updating the object in the work area with the data in the data storage destination

Operating procedure

l(1) Solving the conflict by overwriting the data in the data storage destination with the object
in the work area

1. Select the [Home] tab = the [Work Area] group = [Solve the Data Conflict].

2. Select "Overwrite and register it with the object of work area."
» The data in the server (edited by another user) can be overwritten with the object in the work area (being edited).
« The overlay icon changes to # (Change).

3. Acquire past data (edited by another user) from the history, and merge the changes in the data into the object.

4. Click the [Save] button. (==~ Page 26 Saving an object)
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l(2) Solving the conflict by updating the object in the work area with the data in the data
storage destination

Point ;>

An object being edited in a work area is updated with data edited by another user.
Save data being edited outside the work area in advance.

1. Select the [Home] tab = the [Work Area] group = [Solve the Data Conflict].

2. Select "Update the work area in the object of the data storage destination (Discard the edit data of work area)."
» The object in the work area (being edited) is deleted, and the latest data (edited by another user) is acquired from the
server in the work area.

« The overlay icon changes to @ (Normal).
3. Merge the changes in the object that was being edited into the object in the work area (data edited by another user).

4. Click the [Save] button. (I~ Page 26 Saving an object)
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Canceling a change

A change in an object can be canceled unless the object is saved to a server.

» An object edited in a work area will be the latest data saved to a server.

» An object operated (moved/reserved for deletion) in iQ AppPortal returns to the state before the operation.

» The overlay icons such as E (Conflict), » (Delete Reservation), # (Change), and == (Add) return to ﬁ (Normal).

Home
@ 'D &= Solve the Data Conflict | gy Cr Name - 0 [ Properties ﬁ( [E Verify between Objects B4 import 0
== | W Cancel the Change Bz Re- 251 CHistory [ty Verify with the Latest Data | B Export
. Get the N Classification | 2% Z Refresh Release Hel
X Delete Reservation | [atest Data (=] Re Edit Tile Display = | Refine =P
Edit Work Area C Sort Display Data Operation

et et oo
=

~

~F1 ServoSalutioni-1 ST ServoSolutiond-1
, vol11_cart.r a ®. vol11_cart r_a
= GX Works3 Sample Data GX Works3 Sample Data
2 Vol11_Cart PLC Vol11_Cart PLC
____________ )= LD
___________ b e
& ! Manual . Manual
ServoSolutionl-2 ben-b62005-721_a ServoSolutionl-2 ben-b62005-721_a
Date Modified: Date Medified:
2023/10/02 ) 0030002 | | N ______ )
a Leaflet a Leaflet
ot df
IF 103106a Ia- 103106a
] ]

When a change is canceled, the change for the lower layer is also canceled.

Operating procedure
Select the [Home] tab => the [Work Area] group = [Cancel the Change].

Precautions

If data in a server is updated by another user before canceling a change, the updated data is acquired in a work area.
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Restoring a work area

If an error such as 'failed to restore work area' occurs while operating iQ AppPortal, a work area must be restored in "Restore
Work Area."
Inconsistency between data in a server and an object in a work area can be solved by restoring the work area.

[Ex]

If the status is inconsistent between data in a server and an object in a work area
Data in the server is saved but the object in the work area is not saved in iQ AppPortal.

Window.

Select the [File] tab = [Option] = "Restore Work Area."

Basic Setting
When error occur at “failed to restore work area” in the MELSOFTiQ AppPortal in operation,

Object 1 please check the followings and execute "Restore Waork Area",

Object 2 The restoration of work area is necessary that means the correct data in problem of

2 connection with the server is not saved and the work area is in the conflict status.

egister Cannot continue to use the work area in this status.

Verify The conflict status can be solved and the work area can be used by execute restore work
area.

Restore Work Area

If failed to restore work area, the following reasons may be responsible.

- The file in the work area is opened.

- The file in the work area is damaged.

- The work area does not have access authority.
- The file of work area is read-only attribute.

Please check the above and execute "Restore Work Area”.

Restare Work Area

* If cannot restore work area by the above operation, please change the using work BQ

Operating procedure
Click the [Restore Work Area] button.
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Increasing the display speed in the object list area

The display speed in the object list area can be increased by saving the status of an object to the cache (temporary file) and
using it when updating the display to reduce the number of times of communication with a server.

Window
Select the [File] tab = [Option] = "Object 1."

Basic Setting

Object Filtering
Object 1
Display the deleted object(S)
Object 2 Display the read-only attribute folder(R)
Register The option at output
Verify [7] Start the explorer at get the latest data(E)
Restore Work Area Classification Option

[] Display the name of classification added to object. (At the time of list display)(Q)
Callout Praperty Option

[] Enable Editing of Callout Property(V)

It is possible to edit the name, model name, outline, image, author, and remark.

The display item other than the name can be selected.

Display ltem(D): tem Name
Date Modified

v| Model Name

v Outline

v Feature

v Image

[E

Cache Setting

@ Enable Cache(C

T Disable Cache(1)
If cache setting is enabled, the screen can be displayed faster. But if enabled, the displayed
folder cannot be displayed in the latest state sometimes. The latest state can be displayed
by selecting the folder which the latest state want to be confirmed.

‘When refresh all the object cache, please execute "Cache Refresh®.

Cache Refresh

Operating procedure

Select "Enable Cache" under "Cache Setting," and click the [OK] button.

Operation when caching is enabled
When caching is enabled, an overlay icon may not be updated. In this case, select the folder to update it.
To update the overlay icons of all folders, click the [Cache Refresh] button.
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Setting the icon colors of objects

The icon color of an object other than one of MELSOFT products can be set for each extension.
It is white if no color is set for an extension.

Precautions

Colors are set by default for some extensions.
Only the colors can be changed from the default settings; the extension names cannot be changed and the settings
themselves cannot be deleted.

Window
Select the [File] tab = [Option] = "Object 2."

|

Option

Basic Setting
Object lcon Display Setting
Object 1
. Set the object icon.
Er= Save this setting data in server.
Register
Verity B Extension Eeet] =S ServoSolutiont
e L
Restore Work Area 4 M ppt . EChnocksienson(KIN E:I vol11_cart r a
5 [ == | Delete(D)
6 M e Color(L} .Iz‘
7 W o 5 Project0
A SiE|  Vorm cortpic
9 W dam
0 W xs A [
oo [ el
1) 11 Wl xsm ) ben-b62005-721_a
12 M udsx
13 M vd
14 Wl ovedx = aimg | s|os1214alema
15 H vsdm a
16 | T
17 W pdf
18 M accdb it | Memo.bet 3)
: 19 M mde . 2
\i_u-_-_-.-.z-:’-_-_-.-_-_-_-./
e empf M
[ |
2) e ema 7
E bat :
\ y= - PAS

(1): Default settings
(2): Newly created settings
(3): If no color is set for the extension

Operating procedure

ECreating a new setting

1. Click the [New] button.
A row is added in the list.

2. Select a color from the pull-down list of m[¥].
3. Enter an extension name in the "Extension” column, and click the [OK] button. (Up to 32 characters)

EChanging an extension name

1. Perform either of the following operations:
* Double-click an extension name.
» Select a setting to change its extension name, and click the [Change Extension] button.

2. Enter an extension name in the "Extension” column, and click the [OK] button. (Up to 32 characters)

4 OBJECT MANAGEMENT
50 4.4 Object Utilization



EChanging a color

1. Selecta setting to change its color.

2. Select a color from the pull-down list of m[¥].
3. Click the [OK] button.

EDeleting a setting

1. Selecta setting to delete.

2. Click the [Delete] button.

3. Click the [OK] button.

HRestoring colors to their defaults

1. Clickthe [Restore the Default Settings] button.
Only the icon colors set by default return to their defaults.

2. Click the [OK] button.
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4.5 History Management

This section shows the details on managing data, a saved comment, and the property information when performing each
operation (add/change/delete) for an object as histories in a server via iQ AppPortal.

Precautions

An operation (add/change/delete) for an object is managed as a history but the following operations are not saved as
histories:

» Changing a property

« Editing or adding a classification

When performing a same operation (add/delete) for an object, only the latest operation is saved as a history.
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Checking a change history of an object

The history list of an object and a comment entered when saving the object to a server can be checked in the "History"
screen.

Window
Select the [Home] tab = the [Display] group = [History].

File Home

Copy i Name - [éa Properties [ Verify between Objects Import
784 (7]
Paste _—n Al A Verify with the Latest Data Export
- Get the Classiication | 2% 2T Refresh | 2 &
Edit

M Delete Reservation | | atest Data Ha:lp

History

> = k the history from the histor
cted data” button.
S
al ServoSolution1
ServoSolutionl vol11_cart_r_a
Date Modified: Revision Action Date Comment
EE R BN s \ 3 n Change 2023/10/10 11:02:20 GX Works3
8 GX Works3 Sample Data | |Change 2023/10/10 11:00: |Change
(-7 Vol11_Cart_PLC : |Add |2023/w/1o 10:58:05 |New
=0
gj = Manual
ServoSolutionl-2 ben-b62005-721 a
Date Modified: - ST —
2023/10/10
Comment
e Leaflet GX Works3 Project
a- 103108a

LEVIN G Works3 Sample Data

2016/03/26 10:03:41

LELCN Vol11_Cart_PLC

SELEN A oplication program example for Automated Guided Vehicle.
PLC CPU:R04CPU Simple Motion madule:RDT7MS4

Roa
GX Works3
[Detailed Display}
[Detailed Display}

Program:1
FB/FUN:3
Title

v
v
v
v

Comment

Image

MITSUBISHI ELECTRIC CORPORATION

2016/03/26 11:10:15

2015/03/17 19:11:24

1,254,022 Byte

EENEL Vol 11_Cart PLC.gi3

Remark

Details when editing an object are displayed in "Revision," "Action" (add/change/delete), and "Date" under "History List."
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Acquiring past data of an object from the history

Past data of an object can be acquired from "History List."

x

Close

Please select the revision which wants to check the history from the history list.
3 i comment and isplayed.
i selected data” button.

can be verified after specifying th v
nt acquiring revision is displayed with bold.

Revision Action Date Comment
73 Change 2023/10/10 10:45:18 GX Works3 Project

72 (Change 2023/10/10 10:38:56 |Change

71 iAdd 2023/10/10 10:38:09 New

estination: -) Acquire the selected data

Comment

GX Works3 Project

Operating procedure
1. Selecta history from "History List" in the "History" screen.
2. Click the [Acquire the selected data] button.

3. Specify an output destination for the selected past data of the object.

To prevent data from being overwritten, a folder different from one in a work area must be specified as the
output destination for past data of an object.

Precautions

The history of acquired past data of an object is not retained. It is treated in the same way as new registration when re-

registering it after editing.

4 4 OBJECT MANAGEMENT
5 4.5 History Management



Browsing/acquiring a deleted object

Data of a deleted object can be acquired in the history screen after displaying the deleted object.

Deleted object display

A deleted folder and object can be displayed by setting an option.

Window.

Select the [File] tab = [Option] = "Object 1."

Basic Setting
Object 1
Object 2
Register
Verify

Restore Work Area

Object Filtering

Display the deleted object(s)
er(®)

Display the read-only attribute fold:
The option at output.

[] Start the explorer at get the latest data(E)
Classification Option

[ Display the name of classification added to ebject. (At the time of lst display)(Q)
Callout Property Option

[] Enable Editing of Callout Property(V)

It is possible to edit the name, model name, outline, image, author, and remark,

The display item other than the name can be selected.

Display Item(C}:

Item Name
Date Modified ~
V Model Name
V) Qutline
V Feature
 Image

Cache Setting
@ Enable Cache(Q)
© Disable Cache(N)

If cache setting is enabled, the screen can be displayed faster. But if enabled, the displayed
folder cannot be displayed in the latest state sometimes. The latest state can be displayed
by selecting the folder which the latest state want to be confirmed.

When refresh all the object cache, please execute "Cache Refresh”.

Cache Refresh

G

Operating procedure

>

[} \
= | =
: = :\ ] = ServoSolution2-1
| ServoSolution2 || ServoSolution2-1 o il cara
|| Date Modified: l‘ Date Modified:
| 202371005 | 2023/10/05
)
! ! GX Works3 Sample Data
1 m i
\ ; @ Vol11_Cart_PLC
,,,,,,,, /|
= =
@ || =
er ion: ben-b62005-721
Date Medified: Date Medified: - -
2023/10/05 2023/10/05
v Leaflet
F 1031083

P

Select the checkbox of "Display the deleted object" under "Object Filtering," and click the [OK] button.
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Deleted object acquisition
Past data of an object can be acquired in the "History" screen of the deleted object.

[ Verify between Objects Import

fru) Verify 1 P e
Verify with the Latest Data Export

lZe) &.Bp

File ' [ERea.

[PyCopy
Help

- @ Name -
— Al A

Classification zl 2t

Edi

) . Get the
¢ Delete Reservation | |atest Data

£l [iE] #

File ' Home
>
i wan heck the history from the history list.

= ==

| a ServoSolution2-1
ServoSolution2 ServoSolution2-1
Date Modified: Date Modified:

2023/10/06 2023/10/06
Comment
GX Works3 Sample Data
T Delet
& Vol11_Cart PLC ==

== = =

ol o Manual

ServoSolution2-2 ServoSolution3 ben-b62005-721 =

Date Modified: Date Modified:

2023/10/06 2023/10/06
 Leaflet Verify betweer 5 Destination: -} Acquire the selected data
y ) .
() I03106a >
— [
=l | | =0l e

Operating procedure
1. Select a deleted object, and select [History] in the [Home] tab = the [Display] group.

2. Selecta history under "History List" in the "History" screen, and click the [Acquire the selected data] button.

3. Specify an output destination for the selected past data of the object.

Precautions
The history of acquired past data of an object is not retained. It is treated in the same way as new registration when re-

registering it after editing.
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4.6 Branch Management

This section shows the details on branches created when utilizing folders saved to a server.

A folder duplicated by creating a branch can be customized independently from its source folder.

The relationship between a duplicated branch and its source folder is displayed in a tree structure in the revision graph. This
enables visual management.

Creating a branch

To create a branch from the latest folder, select a folder on iQ AppPortal.

File ' [ERea.

(F4Copy 'B =So + || Kgy Create Branch ‘-’. § Name - 0 [ Properties ﬁ( [52 Verify between Objects B4 Import e
Paste == WA Cancel ge ion Graph a4 CHistory ¥ Verify with the Latest Data | & Export
. Get the B Classification = Z¥ 2 Refresh Release Hel
3¢ Delcte Reservation | | atest Data Revision Graph [Selected Folder] Edit Tile Display  *| Refine <lp
Edit Work Area Configuration Management or Disg Verify Data Operation

1 ServoSolution-1

+ voll1_cart_r.a

1 ServoSolution
@ vol11_cart_r_a

2718 GX Works3 Sample Data
& Vol11_Cart PLC

278 GX Werks3 Sample Data
+ Vol11_Cart PLC

§ Manual g Manuzl
i | lpdi |
@ bon-b62005-721a + ben-b62005-721_a
Leaflet Leaflet
@ l03106a + 103106a

Operating procedure
1. Select the [Home] tab = the [Configuration Management] group = [Create Branch].

2. Click the [Save] button. (==~ Page 26 Saving an object)
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Displaying a revision graph

A revision graph is a graph for displaying revisions of folders related to a selected folder in a tree structure.

Only revisions of a selected folder can also be displayed.

A revision graph can be displayed in the following screens:
» "Revision Graph" screen: Revisions of folders related to a selected folder are displayed.

+ "Revision Graph [Selected Folder]" screen: Only revisions of a selected folder are displayed.
In addition to the revision graph, the history list and revision details are also displayed in these screens. (== Page 63

Revision refinement)

Aegesy
o - [ Properties ﬂ( rify between Objects B% Import e

[ Copy _D &= Solv ata Conflict | gy Create Branch 5 Name 0
Paste == A Cancel the Change Revision Graph al a1 O History [y Verify with the Latest Data | B Export
Get the Classification | 2% 2 Refresh Release Hel,
3 Delete Reservation | |atest Data Revision Graph [Selected Folder] Edit Tile Display  ~| Refine e
Edit Work Area Configuration M andglfn'f-'l§zz ati Sort Display Data Operation

ServoSolution1-2
Date Modified:
2022/11/14

Display Revision Details | ‘ Create Branch

Switch Display: Layer: Verify between Revisions | Source:d Destination: - Display Objects in Folder
Revision No. 2 3 4 5 © History List ’
2022,
114 | 2022011714 i x
L 1 -
. Revision No. Action Date Folder Na... Comment
1025 Cha... | 2022/11/149:5332| servosolut..| [USER] 2
2 2% Cha... | 2022/11/14 9:52:19| ServoSolut..| [USER] v
5 ServoSolution2 H
............................ <] W | >
B it ot H
H Save History List
H 2022111114
ServaSolution1- H
~£Rly H
2 Termrmrmrm e e e s D o Dt (Revision No. 4) Display Change Object List
volll_cart_r_a H
— H Date:2022/11/14 09:45:14 - Change Object List (9)
P— H 202211114 Folder Name:ServaSolution1-1 -
ervoSolution1- H
T | ... [ Comment GX Works3 Sample Data |
volll_cart r a H [USER] Vall1_Cart PLC
- < > W

Verify between Revisions | [Sourcet23) Destination: - Display Revision Details ‘ | Create Branch

Revision No. 2 3 23 24 % History List >
2022411114 | 20221114 [ 2022H1/14 | 2022111114 | 2022 Fry x
L 1 1 1 | -
Revision No.  Action | Date Folder Na... | Comment
1 25 Cha... | 2022/11/14 9:53:32| ServoSolut...[ [USER] él
2 24 Cha... | 2022/11/14 9:52:19| ServoSolut...[ [USER] v
< u | >

Save History List

Revision Details (Revision No. 23) Display Change Object List
Date:2022/11/14 09:51:35 Change Object List (1)
Folder Name:ServoSolution1

EIriTE -E:I- GX Works2 Sample Data
[USER] 3 Vel11_Cart_PLC

< >

The selected folder is displayed in bold.
A deleted folder is displayed in gray.
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Operating procedure
1. Select a folder in the object list area or application tree area.

2. Selectthe [Home] tab = the [Configuration Management] group = [Revision Graph] or [Revision Graph [Selected
Folder]].

Point

By classifying folders for each purpose, they can easily be found when displaying the revision graph.
(=5~ Page 32 Object Search

Switch Display:

Laye | Display Objectsin Folder | | Display Revision Details | | Create Branch

6 55 56 57 58 <
2023/11/07 ~

-a@J -

ervoSolution! | | LineA EquipmentA LineA_Equipment’ = » 1
e Modifed: Date Modified: Date Modifed:

2231107 22311/07 202311/07 voll1_cart ra H

4 H

e Modified:

S8 LineC_EquipmentA S N S A S
[ o s :
“ :

ineC_Equipments
M1 cart r 2

(
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Tree structure display switching

The display of a tree structure can be switched by clicking (display upper and lower folders only) or (display all
folders) to the right of "Switch Display."

This operation is available in the "Revision Graph" screen only.

EWhen displaying only upper and lower folders of a selected folder in a tree
(Display upper and lower folders only)

Revision Graph

Switch Display: fzz| Layer | |EZ|| Display Objects in Folder | | Display Revision Details | | Create Branch
Nz
RE 87 83 97 9 100 <
2021/09/07 | 2021/09/07
B ServoSolution] L 1
- vol11_cart_r_a H
L
2021/09/07
=i ServoSolution2 S S _—
[ voit1 cart.r a H
K
2021/09/07
H
=8 ServoSolution2-2 T S A | N—
[ voit1_cort r a H
H
2021/09/07
= ServoSolution2-1 S - | I ——
- volll_cart_ra

Point/®

A branch source folder is an upper one, and a folder duplicated from a selected folder is a lower one.

T T T T T T T T T e T )
212 213 214 |
——— — [}
: L}
ot Solution’ Solutiont-1 |
----------- P ——=a -
215 = 216 S
Solution2 Solution2-1
217 —
Solution2-2

"7 Range of upper and lower folders

S

EWhen displaying all folders related to a selected folder in a tree
(Display all folders)

Revision Graph

Switch Display: | | - Layer: |“F Verify between Revisions || Display Objects in Folder | | Display Revision Details | | Creste Branch
E E= ¥ play Obj play
Revisi .’Q 87 28 1] u 95 97 99 100 ¢
2021/09/07 | 2021/08/07
E ServoSolution ] 1 1
B it catc
o
H 2021/09/07
=] ServoSolution2 ] e e A e E—
- vol11_cart_r.a H H
L
H H 2021/09,
5 ServoSolution2-2 H [ |
I o1 cart ¢ n H H
H H
H 2021/09/07
H H
E ServoSolution2-1 H H | I —
[ voit1 cart r 2 :
2021/09/07
=5 ServoSolution1-2 ) A |
- vol11_cartr_a H
2021/09/07
i ServoSolution1-1 S L
B ot catc H
| H
2021/09/07
:
—E] ServoSolution1-1-1 HY I |
- voll1_cart_r_a
< [0 >
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Layer display switching

The display of a selected folder can be switched for each layer by clicking (Open All Layers) or (Close All Layers) to
the right of "Layer."

In addition, lower folders of a selected folder can be expanded and collapsed by clicking » (expand the layer) at the bottom
left of the folder.

These operations are available in the "Revision Graph" screen only.

EWhen opening all layers
(Open All Layers)

Revision Graph

Switch Display: Layer: |°F Verify between Revisions || Display Objects in Folder | | Display Revision Details | | Create Branch
Revision No. &7 88 91 94 95 97 9 100 ¢
2021/09/07 | 2021/09/07
=5 ServoSolutiont 1 1
[ volt1 cart.ra :
l
H 2021/09/07
—i1 ServoSolution2 - e A S E—
- voll1_cart_r_a H H
"
2021703,
5 ServoSolution2-2 H - s | -
B it ot H H
: 2021/09/07
: H
E ServoSolution2-1 H H | I —
[ voit1 cart r 2 :
2021/08/07
=5 ServoSolution1-2 ) A |
- vol11_cartr_a H
2021/08/07
i ServoSolution1-1 S L
B ot catc H
| H
2021/09/07
:
—E] ServoSolution1-1-1 HY I |
- voll1_cart_r_a
< i )

EWhen closing all layers
(Close All Layers)

Switch Display: Layer: E ‘erify between Revisions || Display Objects in Folder Display Revision Details Create Branch

<
Revision Ne. N 83 9 94 95 97 99 100
2021/08/07 | 2021/09/07
—=] ServoSolution1 L 1
- voll1_cart_r_a H
2
<| [T HE

EWhen expanding and collapsing lower folders of a selected folder
» (Expand the layer)

I r@j Solution

r@il Solution1
I!h
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Display of objects in a selected folder

Objects in a selected folder can be displayed in the application tree area.
This operation is available in the "Revision Graph" screen only.

Get the Latest Data | Save

5 Solution1

o

Cancel

% Vol11_Cart_PLC
LY

H 2020/09/14 ~
i " Solution1 =
l ......... -I—I:I —
i H g Manu
= = & | bcn-b62005-721a
[ I — >

g Leaflet
&__|

lo3106a

Operating procedure
Click the [Display Objects in Folder] button.

Revision details display

A comment when saving or the list of changed objects of a selected folder can be displayed.

Revision Details

Comment

Date:2021/12/15 17:21:05

Switch Display: m Display Objects in Folder | || Display Revision Details | | Create Branch
.. I‘ I | ‘ [User]Change
Revision No. 33 34 35 6 <
2021/12/15 ~
e . —
=1 ServoSolution1 1
[ voitt cart ra
v
<
< Cw

hange Object List (2)

Vol11_Cart_PLC

GX Works3 Sample Data

i Prj1_se
F
v

Operating procedure

Click the [Display Revision Details] button.

Branch creation

A duplicate of a selected folder can be created.

T Display Objects in Folder |||\ Display Revisian Details I Create Branch I

312 <

Revision No.

-i.-‘_i'i Solution1

& Solutionl-a

bl

% GX Works3Praject
+i

103106a.pdf
+_|

Operating procedure

1. Clickthe [Create Branch] button.
2. Enter a folder name.
3. Click the [Save] button. (==~ Page 26 Saving an object)
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Revision refinement

Revisions displayed under "History List" can be refined by entering a keyword in the free search box.

Information entered when saving a changed object to a server is displayed in "Comment" under "History List." This enables
quick search of a target revision.
In addition, only objects changed in a selected revision are displayed in "Change Object List." This enables a target object to

easily be found.

Revision Graph O X

Gt Bl Verify between Revisions | |Source:d Destination: - | Display Objects in Folder | | Display Revision Details | | Create Branch J
=
Revision No. 3 4 5 9 10 History List '.’) )
T T 773 O e i o o e i i iy
- 712/ [] n X l—(2)
Ser 1 1 <
volll cart r a - Revision No. Action  Date Folder Name
L H 116 Change | 2021/12/15 17:06:42| ServoSolutio. ™
H 202171215 2 15 Add 2021/12/15 16:58:11|  ServoSolutio.| =
ServoSolution2 T ) AUV [N S | M—
e : : 3 14 Add 2021/12/15 1657:51| ServoSolutio.
2 H H 4 10 Add 2021/12/15 16:57:09| ServoSolutior
H 2021/12/15 5 9 Add 2021/12/15 16:56:32| ServoSolutio. v
ServoSolution1-2 Eassshssssmsmapans — < m
voll1_cart_r_a .
H
H 2021/12/15
H
ServoSolution1-1 Rensnmman L Revision Details (Revision No. 4)
vol11_cart_r_a = ¢
4 o Date:2021/12/15 16:54:59 \ Change Object List (8) |
H 2021/12/15 Folder Name:ServoSolutiont-1 ~N
rii“ll SevoSolution-1-1 | liaiesssssssssss — [ Comment | X Works3 :
vol11_cart_r_a [UserNew | Sample Data — (%)
< ST Vol11_Cart_PLC “li
< ] > | —— )

Operating procedure

Enter a keyword in the free search box.

Displayed.items

No. | ltem Description
(1) [<)/[>] button Click either of these to display or hide "History List" and "Revision Details."
(2) Free search box Revisions can be refined according to the contents in "Date," "Folder Name," and "Comment" by entering a
keyword.
Characters are case-sensitive.
When entering multiple keywords delimited by spaces, revisions including the keywords can be refined.
3) [Save History List] button Click this to output the content displayed under "History List" to a file in CSV format.
(4) Display Change Object List Unselect the checkbox to hide the change object list.
(5) Change Object List Only changed objects are displayed.
They are displayed in order from read ones.
Double-click a displayed object to open. When opening and editing it, save it with a name.
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4.7 Verification

This section shows the details on verifying an object to check changes in the object.

Target objects

The following table shows the objects to be verified.
For verification, a tool supporting a target object must be installed.

Object Tool
GX Works3 project file GX Works3™!
GX Works2 project file GX Works2"!
GT Designer3 (GOT2000) project file GT Designer3™!
Objects other than those of MELSOFT products A set external tool.
For the setting method, refer to the following:
==~ Page 87 Setting an external tool used for verification

*1  For the supported versions, refer to the following:
=~ Page 86 Versions of MELSOFT products used for verification

Verifying two objects

Two objects, which are selected in the object list area, application tree area, "History" screen, "Revision Graph" screen,
"Revision Graph [Selected Folder]" screen, and "Revision Verification Result" screen, can be verified.

Point}3

Objects can be verified even if their names are different.
In addition, objects displayed in different screens can be verified.

Get the Latest Data

Verify between Objects x

Please select the object of verify source or verify destination from the shortcut menu in the main
screen, history screen or revision graph screen.

—E1 Project]

o]

~Verify Source

4

Folder Name: Project1

E Object Name: GX Works3Project_1
Data of Work Area

% GX Works3Project_1 —
o

Change Verify Source and Verify Destination

i~ Verify Destination

Manual Object Name: GX Works3Project_2
5 =

ben-b62005-721_a Folder Name: Project2
Data of Work Area

A

"%

Revision No. 1 History List >
s s
# x
) Project] —_— -
= Revsono. Acien Date FolderName
4 IR Change | 2021/12715 1735:14] Project2 = ResultList + ~
inens 202125
R Change | 2021/12/15 17:3431] Project 3
N R 2 X Verify Source: Data beine Edited Verify Destination: s I 9U00T AL AL e
] 3 9 add__| 200112715 173332] Project2
s ‘noa | 2001215 173028 Project S Saurce Project GH Werks@Project 1 Desthatian Project GX Werks@Project 2
< " > Verify Source Data Name: erify Destination Data Name:
Save History it
= Result List |
Revision Details (Revision No. 11) Display Change Object List
Change Object st 1) No. Type Data Mame(Verify Sourcs) Data Mame(\erify Destination) Verification Result Caution
ject J1 | Program Fils MAIN MAIN W
——————— E'E X Works3Project 2 2 Prosram ProsPau ProsPou Mismatch
A 3 Program(Local Label) ProgPou ProgPou Mateh
¢ Giobal Label Global Global Match
5 Gommon Device Gomment  COMMENT GCOMMENT Match
v 5 Devics Memory MAIN MAIN Match
- 7 Parameter System Parameter System Parameter Watch
8 Parameter GPU Parameter GPU Parameter Match
9 Parameter GPU Module Parameter GPU Module Parameter Match
10 Parameter Module parameter Module parameter Match
< >
2 differences Mismatched Line Source Only Dest. Only
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Operating procedure

1. Selectan object or revision in any of the following:
» Object list area
« Application tree area

"History" screen

"Revision Graph" screen

"Revision Graph [Selected Folder]" screen

"Revision Verification Result" screen

2. Right-click the selected one, and select [Select as Verify Source] or [Select as Verify Destination] from the shortcut

menu.”!
The "Verify between Objects" screen appears, and the corresponding object is displayed in "Verify Source" or "Verify

Destination."

3. Repeat steps 1 and 2 to set objects for "Verify Source" and "Verify Destination" in the "Verify between Objects" screen.

4. Click the [Verify] button.

The verification result is displayed in a tool supporting the object.

*1  When selecting a changed object in the "Revision Verification Result" screen, specify the revision number of a verification source or
verification destination.

Point/@

To display the "Verify between Objects" screen before selecting an object or a revision, select the following

menu:
» [Home] tab = [Verify] group = [Verify between Objects]
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Verifying with the latest data

Data in a work area can be verified with the latest data in a server.

Point/®

File Home

yCopy
Paste

Changes in an object can be checked when its overlay icon is E (Conflict), ,f (Change), or E] (Past

Version Data).

Note that all items may be determined to match in a verification result in the following cases:

» Only information not to be verified in an object is changed (example: comments of a GX Works3 project,
etc.).

» A project is overwritten without being edited.

For information on verification targets of GX Works3, GX Works2, and GT Designer3 project files, refer to the

manual for each tool.

=1

Get the
M Delete Reservation | | atest Data

12, Vierify between Obiects B4 Import

[, Verify with the Latest Data || B Export

i

Classification
Edit

3 [é Properties &(

G History
Refresh Release
Tile Display = | Refine

7]

Help

M Ca

Operating procedure

1. Selectan object in the application tree area.

® ResultList v ~
Lk Verify Source: Data being Edited Verify Destination: Cifllsersk ¥ fippData¥Local¥- -
Sourcs Projest: Vol 11 Gart PLG Destination Projsct: Voll1 Gart PLG
i i~ il Werify Source Data Name: Verify Destination Data Name:
ServoSolutioni-1
ol 65 = ra—
= Result List
ServoSolution-1 ServoSolution2-1 o
Date Modified: Date Modified: 4 No. Type Data Mame(Verify Source)  Data Name(Verfy Destination)  Verification Result  Caution *
2023/10/06 2023/10/06 92 Stctured Data Types  MeRD77 Sulpdochintr WeRD7? Sulnp oxMitr Match
tructured Data Types +RD77 SvlnpéxPrm +RD77 SvlnpAxPrm atc!
s d Data T, WRD 7T SulnphxP MeRDT7 Sulnp AxPr Match
i GX Works3 Sample Data 94 Structured Data Types M+RDT7_SyNethintr M+RDTT_SvNethintr Match
T P 95 Stmctursd Data Types  MRDT7 SvNetPrm WeRD77 SvNetPrm Match
| & Vol11_Cart PLC 96 Stuctured Data Typss  MRD77 SynoAxCtrl 1+RD77 SynsiCtrl Match
| 97 Stuctured Data Types  MeRD77 Syne Axbinir 14+RD77 Syncrxhintr Match
\ 06 Stuctured Data Types  MeRD77 SyncfcPrm MeRDT7 SyncixPrm Match
sl =il 99 Structured Data Types M+RDT7 SyncEncAxCtrl  M+RDT7 SyncEncAxCtrl Match
° 100 Strustued Data Typss ~ M+RD77_SynoEnchxhintr  M+RD77_SynoEnsfxhintr Match
. . Manual 101 Stuctured Data Types  MeRDI7 SyncEncAxPrm  MeRD77.SyncEnchuPrm Match
ServoSolution2-2 ServoSolution3 ) ben-b62005-721_a 102 Structured Data Types MeRDT7 SyneSystrl MHRD77_SyncSysGrl Match
Date Modified: Date Medified: 108 Structured Data Types M+RD77 Sy=Ctrl M+RD77 SysCtrl Match
2023/10/06 2023/10/06 104 Stuctwed Data Types  M+RD77_Syshintr] WRD77 SysMntr | Match
105 Structued Data Types  MrRD77 Syshintr2 1+RD77 SysMntr2 Match
106 Common Device Gomment  COMMENT GOMMENT Match
Leaflet 107 Device Memory MAIN MAIN Match
& 103106a 108 Parameter System Parameter System Parameter Mismatch
109 Parameter GPU Perameter GPU Perameter Mismatch
10 Parameter CPU Module Parameter  GPU Module Parameter Match
ol ool o 111 Parameter Module parameter Module parameter Match
112 Module Extended Paramet.. 00DERDTIMS4 D00CRDFIMSE Match o
< >
2 differences Mismatched Line Saurce Only Dest. Only

2. Select the [Home] tab = the [Verify] group = [Verify with the Latest Datal].
The verification result is displayed in a tool supporting the object.
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Verifying two revisions in the history list

Two revisions can be verified under "History List."

Point/®

Please select the revision which wants to check the histor
The selected revision comment and properti

Changes between revisions more detailed than the comment can be checked.

re displayed.

from the history list.

The corresponding data can be acquired from “Acquire the selected data” button.

The data can be verified after speafying
Current acquiring revision is di

61
30

played w

two revisions.
th bold.

2021/09/07 11:58:37
2021/09/06 1 1

Comment
GXW3 Project|
[Change

5

2021/09/06 15:43:45

MNew

- @

2

2021/09/03 10:55:34

Verify between s (Source: 61 Destinati

Comment

‘GXW3 Project

‘@

Operating procedure

~

G¥liserst, ¢AppData¥Local¥ -

Voll1.Gart FLG

Werification Result  Gaution “

Match
Match
Match
Match
Match
Match
Match
Match
Match
Match
Mismatch
Mismatch
Match
Mismatch
Match
Match
Match
Match
Mismatch
Match
Match
Match
Match
Match
Match
Match
Match
Match
Mismatch
Mizmatch
Mismatch
Mismatch

v

= Result List
erify Seurce: Data beine Edited erify Destination
ource Project Vol I Gart FLG Destination Praject
erify Seurce Data Name: Verify Destination Data Name:
esult List
Mo Type Data Name{Verify Source)  Data Name(Verify Destination)
MAIN
2 FProgram ProgFou ProgFou
3 Programilocal Label)  ProgPou ProgPau
4 FBFik M_FELIB M_FELIB
5 FB/FUN M+RDT7_JOG_10E M+RDT7_JOG_10E
6 FB/FUN(Local Label)  M+RDT7_JOG O0E M+RD77_J0G_10E
7 FB/FUN M+RD77 OperateError 10E  M+RDT7 OperateErrar 10
8 FB/FUN(Local Labell  M+RD77 OperateError 00E  M+RDT7 OperateError 00E
9 FB/FUN M+RD77 StartPositioning .. M+RDT7 StartPasitioning J0E
0 FE/FUN(Local Label)  M+RD77 StartPositioning 0. M+RDT7 StartPositioning 00E
11 Global Label Global Global
12 Global Label M+Global M+Global
18 Structured Data Types  M+RGPU M+ROPL
14 Structred Data Types  M+ROPL Clock Data M+ROP L Clock Data
16 Stuctured Data Types | M+RGPUCOM Refresh Sel..  MeRCPUCOM Refresh Selecti..
16 Structred Data Types  M+RGPU_DataMemory Use..  MrROPU_DataMemory_Lse Go.
17 Structured Data Types  M+RGPU_DevicelabelMem.  M+RCPU_DevicelabelMemory
18 Stuctued Data Types  M+RGPL Error Information  M+RGPL_Error Tnformation
19 Structured Data Types  M+ROPU_Error_Time M+ROPU_Error Time
20 Structured Data Types  MROPU EtherPart M+RGP U EtherPort
21 Structured Data Types  MeROPUF M+ROPLF
22 Stuctured Data Types  M+RGPU Jnternal Buffer Fr.. M+RCFU Intemal Buffer Fres_
23 Structured Data Types  MRGPU Latest Error M+ROP L Latest_Error
2 Structured Data Types  MeROPU_MemoryGard Use..  M+ROPU_MemoryCard Use o
26 Structursd Data Typss  M-ROPU_MuRIplsGPUInfor . M+ROPU_MutiplGPLLinfor mat
% Structured Data Types  MeROPU_MultipleGPUJnstr..  M+ROPL_MultipleGPLLnstruct
27 Structred Data Types  MROPU MROPU
28 Structured Data Types  MAROPUQ Series Module_..  M+RGPLIQ) Series Module Tnst
20 Stuctured Data Types  MeRGPU Scan Time M+RCFU_Soan Time
30 Structured Data Typss  W+RGPUSD M+ROPLLSD
31 Structured Data Types  M+ROPUSD Dataloeeine . M+ROPLLSD_Dataloeeine Setti
32 Structred Data Types  M-ROPUSM M+RGP U SM
33 Structured Data Types  M+ROPU SM Datalogeine .. M+RGPLISM Datalogeing Setti
4 differsnces
<

Select an object in the application tree area, and display its history. (I~ Page 52 History Management)

1. Click the revision (1) for a verification source.
2. Click the revision (2) for a verification destination with the

3. Click the [Verify between Revisions] button.
The verification result is displayed in a tool supporting the object.

key held down.
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Verifying an object in two revisions in the revision graph

An object between revisions can be verified in the "Revision Graph" and "Revision Graph [Selected Folder]" screens.

Point/®

Changes in a folder duplicated by creating a branch and those in an object changed between revisions can be
checked.

Switch Display: Source:4 Destination: 16 Display Objects n Folder | | Display Revision Defails | | Create Branch
Revision No. 9 10 14 15 16 History List >
H 202111215 ~
s & «
ServoSolution2-2 [ g
T e Revision No. Action __ Date Folder Name
1| 1.8 Change | 2021/12/15 17:0642| ServoSolution1-1. ]g— (2)
2021112115
2 15 Add | 2021/12/15 16:58:11| ServoSolution2-2
ServoSelution2-1 S S —
volllcartra 3 14 Add | 2021/12/15 16:57:51| ServoSolution2-1 =
4 10 Add | 2021/12/15 16:57:09| ServoSolution2
oz 5 9 Add | 2021/12/15 16:56:32| ServoSolution?-1...| |
SevoSolution-2  |iicesesssemeas L
volllcartra 6 _5 Add | 2021/12/15 16:55:26] ServoSolution1-2
74 add | 2021/12/15 16:54:58] ServoSolution1-1 ]—— (1)
2021712115 <] " | >
ServoSolution1-1 L
A e
volll_cart.ra (1) s b Save History List
2021112115 2021/12/15 Revision Details (Revision No. 4) Display Change Object List
ServaSelutiont-1-1 HY TSI 1 i
volll_cartr.a Date:2021/12/15 16:54:59 Change Object List (8)
Folder Name:ServaSolution1-1 ~
T Comment GX Works? =
L [UserlNew Sample Data
2) © | N Vol11_Cart PLC
< I W B
Revision Verification Result sult [Project]
= ResultList ~
- Verify Source Crange Objectlist() |
I Verify Source: Data being Edited Verify Destination G¥lsers¥ ¥AppData¥Local¥T-
ﬁ Folder Name: ServoSolution1-1 GX Works3 Sample Data Seurce Project Vol |1 Cart PLC Destination Project: Vol 11.Cart PLC
Date: 2021/12/15 16:54:59 Vol11_Cart_PLC erify Source Data Mame: Verify Destination Data Name:
Comment
[WUserlNew = Result List
< > Mo, Type Data NamedVerify Source) Data Name{Verify Destination) Verification Result Gaution *
1| Program File_____[ MAIN MAIN [Mismatch |}
- Verify Destination 2 Program ProePou Prog Pou Match
) #  Program(Local Label)  FrosPou ProgPou Maich
Revision Mo 16 + FBFik M_FELIB M_FELIE Match
e 5 FEFUN MHRDT7_JOG_00E M+RDTT_J0G 00E Match
Date: 2021/12/1517:06:42 6 FB/FUNLocal Label)  M+RDT7_JOG 00E I+RDTT_JOG_D0E Match
G 7 FBAFUN M4RD7T CperateEmor 00E MeRD77 OperateErr_00E Match
[User|Change 8 FBFUNLocal Label)  M+RDT7 OpersteError D0E M+RDT7 OperateErrar_00E Match
9 FBRAFUN M+RDT7 StartPositioning I0E  M#RD77 StartPositioning_I0E Match
< > Change (1) :? ;?/FUN(LDC&\ Label)  M+RD77 StartPositioning UE  M#RD77 StartFositioning_00E Match
lobal Label Global Global Match
12 Global Label M+Glabal M+Global Mismatch
18 Structured Data Tupes  M+RGFU MeRCFU Mismatch
14 Structured Dats Types M+RGPU Glock Data MFRGPU Glock Data Match
15 Stuctured Data Types  M+RGFU GOM Refresh Selec.. M+ROPU_COM Refrech Selection  Mismatch
16 Structured Data Types  M+ROPL Databemory Use 5.. MeROPU DataMemary_Use Conditi.. ~Match
17 Structured Data Topes  M+ROPL DeviceLabelMemory.. MeROPU DeviceLabelMemory Use.. Match
18 Structured Data Types  M+ROPLU Error Tnformation  MeRGPUL Error_information Maich v
< >
12 differences Mismatched Line Source Only Dest. Only

Operating procedure
Select a folder in the object list area, and display its revision graph. (==~ Page 58 Displaying a revision graph)
1. Click the revision (1) for a verification source.
2. Click the revision (2) for a verification destination with the key held down.

3. Click the [Verify between Revisions] button.
The revision verification result is displayed.

Item Description

Verify Source The folder information of a verification source is displayed.

Verify Destination The folder information of a verification destination is displayed.

Change Object List Changed, added, or deleted objects are listed.

They are displayed in order from read ones.

4. Double-click a changed object in "Change Object List."
The verification result is displayed in a tool supporting the object.
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4.8 Import and Export of Objects

This section shows the details on importing or exporting multiple folders and objects to register or output them in a batch.

These operations enable efficient work when handling multiple folders, such as for the operation start of iQ AppPortal or
server migration.

Importing objects

Multiple folders and objects can be registered in iQ AppPortal and saved to a server in a batch.
There are two selectable methods for registering folders. For details, refer to the following:
[=5~ Page 79 Folder format object

Window.

Select the [Home] tab = the [Data Operation] group = [Import].

Register the selected folder in the import list to the server in a batch mode.

Please specify the importing path and then press “Read” button.

When error occurred, after it is solved, please press “Refresh Import List" button to ensure the error has been
resalved.

Import Result

Please refer to the manual for the detail of importable folder configuration.
- Progress
Display Manuals Registering the selected folder.
Please wait for a while. Cannot register correctly if folder configuration of the registering folder is
Path(?)
changed.
Cwork If canceled, the registered folder are not changed before canceling.
L) 100% (171)
import st Refesh Impor Lty |
Name Cancel
- )

4 ServoSolution I mport Resut

Evencaepc ¥ Import is started ------

e’ ServoSolutionigap ServoSolution has been registered.

= benb62005-721apdf Import is completed ———

I 1031063.pdf
Error Output
ServoSolution2-2 .
The same name folder has been registered already. E

v
Save in the file(S)...

[ importy | Cancel

Operating procedure

1. Specify the path to a folder to register by either of the following operations:
Click the [Browse] button to specify a folder, or enter the path directly under "Path.""!

2. Click the [Read] button.

3. Select the checkbox of a folder to register.
4. Click the [Import] button.

*1 Specify a folder in the one-level upper layer.

Point}3
By right-clicking a folder or object in the import list and selecting [Open the Place of Object] from the shortcut

menu, the corresponding folder opens in Windows Explorer.
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Folder configuration that cannot be imported

An error occurs and a folder does not appear under "Import List" in the following cases:

HIf the layer structure is incorrect

If the layer structure of an object in a folder is incorrect, an error occurs.
For the layer structure of an object, refer to the following:

[Z=~ Page 78 Object configuration rules

HIf an object with the same name exists
According to the object configuration rules, all objects other than those of MELSOFT products are placed as other files in the

second layer immediately under a folder.

As a result, if another object with the same name already exists in the second layer, an error occurs.
For the object configuration rules, refer to the following:

[Z=~ Page 78 Object configuration rules

HIf a folder cannot be accessed
If a user does not have the access right to a folder, an error occurs.

Precautions

Neither object nor property can be saved to a server from another client during import.
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Exporting objects

Data saved to a server can be output to a folder in a batch.

Window
Select the [Home] tab = the [Data Operation] group = [Export].

Qutput the selectad folder in the export list from the server in a batch mode.
Please specify the export destination. Create the "AppPortal” folder in the specified path and then export.

Display the folders which matches the same refine conditions to object list area in export list. To change conditions,

please once close the screen, after changing conditions then open export screen again. Export Result
- Progress
Path(®) Outputting the selected folder.
CAIQAPT Please wait for a while.
If canceled, the outputting completed folder are not changed before canceling.
Export List(l) 100% (24/24)
* [ —
A @ Project] ~ -
] GX Works3Project e
4 [J] 5 ServoSolution
- Export Result
] GX Works3 Sample Data Output ServoSolution1. -
= Manual QOutput ServoSolution1-1.
E Leaflet ‘Output ServoSolution2-1. @
b %) ServoSolution1-1 Output ServoSolution3.
» O] % ServoSolution1-2 Output ServoSolution3-1.
Output ServoSolution3-1-1.
b [ i ServoSolution2
- X Qutput ServoSolution3-1-1A. v
b [ £% ServoSolution2-1
v [] £ ServoSolution2-2
I % ServoSelution3 v

Export the information file(l)

When transiting to the other MELSOFT iQ AppPortal Server, object property information can be inherited by
exparting the information file.

Operating procedure

1. Specify the path to a folder to output by either of the following operations:
Click the [Browse] button to specify a folder, or enter the path directly under "Path."
2. Select the checkbox of a folder to output under "Export List."

3. When exporting a MELSOFT iQ AppPortal information file (.igap), select the checkbox of "Export the information file."
By exporting a MELSOFT iQ AppPortal information file (.iqap), the property information can be retained when saving the
folder to another server.

4. Click the [Export] button.

Point
If objects displayed in the object list area are refined by a keyword, the smart filter, or classification, the
condition is applied to "Export List."
To change the condition, close the "Export" screen once, change the condition, and then open the "Export"
screen again.

Precautions

The following types of folders do not appear under "Export List."

» Read-only attribute folder

* Folder with the object status of Add

» Folder added by another client after opening the "Export" screen
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APPENDIX

Appendix 1 Additions and Changes from Previous

Version

This section shows the additions and changes with upgrade.

Version 1.01B

Item

Description

Reference

The folder configuration in a work area is changed.

Page 89 Update from iQ AppPortal Version
1.00A

Version 1.04E

Item

Description

Reference

Creating a branch

Branches can be created based on information on a folder saved to a
server.

Revision graph

A branch source folder and a folder duplicated by creating a branch can be
displayed in a tree structure.

Page 57 Branch Management

Linking with tools

Tools for editing can be started in iQ AppPortal.

Page 43 Editing an object

When changing a folder name in iQ AppPortal, the corresponding one in a
work area is also changed.

Page 85 Folder configuration in a work area

Version 1.07H

Item

Description

Reference

Classification

Up to 100 classifications can be created.

"AND" or "OR" can be selected for searching by classifications.

Page 35 Searching by a classification

Import and export

Folders can be imported or exported in a batch.

Page 69 Import and Export of Objects

RT ToolBox3

Workspaces created in RT ToolBox3 can be registered and managed.

Registering and saving
objects

* Up to 200 objects can be registered in one folder.
« Up to 10,000 folders and objects can be saved to a server in total.

Page 23 Object Registration/Save/Deletion

Display speed

The display speed in the object list area is increased by enabling caching.

Page 49 Increasing the display speed in the
object list area

Version 1.11M

Item

Description

Reference

Operating system

Windows 10 loT Enterprise 2016 LTSB and Windows Server® 2016
(Standard and Essentials) are supported.

LT1iQ AppPortal Installation Instructions

Data storage destination

Up to 100 data storage destinations can be created in one server.

Page 16 Data Storage Destination/Work Area
Setting

Repository A repository is displayed in the data storage destination/work area setting Page 20 Screen Configuration
area.
Comment Up to 2,000 characters can be entered in a comment. Page 26 Saving an object

Retaining search conditions

The object list area can be displayed with a condition specified for a search
retained even when restarting iQ AppPortal.

Page 32 Object Search

Revision graph

Folders can be expanded and collapsed for each layer in the revision graph.

Page 61 Layer display switching
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Revision graph The history list and revision details can be displayed in the "Revision Graph" | Page 63 Revision refinement
screen.

Verification Changes in an object can be checked by verifying the object. Page 64 Verification
Hiding read-only attribute Read-only attribute folders can be hidden. Page 84 Hiding read-only attribute folders
folders
Revision graph « The display speed in the change object list is increased in the "Revision | Page 57 Branch Management
Graph" screen. Page 64 Verification

« Revisions for a verification source and destination are displayed in
different background colors in the "Revision Graph" screen.

GX Developer Projects created in GX Developer can be registered and managed.
Folder format object Folders can be registered and managed as folder format objects. Page 79 Folder format object
Verification Objects other than those of MELSOFT products can be verified by using an | Page 64 Verification
external tool. Page 87 Setting an external tool used for
verification
Server specifications « The version of VisualSVN Server is updated from 3.4.2 to 4.3.3. Page 75 Server specifications for using iQ
« The connection method for VisualSVN Server is changed from HTTP to AppPortal
HTTPS.
Verification Any two objects can be verified. Page 22 Menu List
Page 64 Verifying two objects
Search The following operations can be performed when refining objects: —

« Registering a new object

« Registering an additional object
* Moving an object

« Importing an object

« Creating a branch
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Version 1.29F

Item

Description

Reference

Operating system

The following operating systems are supported:
* Windows 11

» Windows Server 2019

« Windows Server 2022

LT1iQ AppPortal Installation Instructions

Server specifications

The version of VisualSVN Server is updated from 4.3.3 to 4.3.7.

Page 76 Version 1.26C or later

Object list area

Objects can also be listed.

Page 20 Screen Configuration
Page 22 Menu List

Application tree area

Folder and object names are displayed in up to two lines.

Revision graph

« Folder names are displayed in up to two lines.

« The width of the "Revision No." column can be adjusted.

« The width of the change object list can be adjusted by using the
separator.

Revision details display
Revision verification result

« Folder names are displayed in up to two lines.
« The width of the change object list can be adjusted by using the
separator.

Version 1.32J

Item

Description

Reference

Operating system

The following operating systems are no longer supported:
» Windows 7

* Windows 8

» Windows Server 2008 R2

L1iQ AppPortal Installation Instructions

Server specifications

The version of VisualSVN Server is updated from 4.3.7 to 5.0.3.

Page 76 Version 1.26C or later

Editing property information

Property information can be edited in the callout property.

Page 18 Callout property option
Page 30 Editing in the callout property

Revision graph [selected
folder]

Only revisions of a folder selected in the object list area or application tree
area can be displayed.

Page 58 Displaying a revision graph

Version 1.38Q

Item

Description

Reference

Operating system

The following operating systems are no longer supported:
» Windows 8.1
» Windows Server 2012 R2

LT1iQ AppPortal Installation Instructions

Classification

The names of classifications added to folders and objects can be displayed
in the object list area.

Page 18 Classification option
Page 41 Classification name display

Up to 5000 classifications can be created.

Page 37 Adding a classification

Classification types can be set.

Page 38 Classification type setting

The display positions of classifications can be set.

Page 39 Display position setting for each
classification

Object icon display setting

The icon color of an object other than one of MELSOFT products can be set
for each extension.

Page 19 Object icon display setting
Page 50 Setting the icon colors of objects

Object list area

The display order of folders and objects is retained even after ending iQ
AppPortal.
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Appendix 2 Specifications of iQ AppPortal

This section shows the specifications and restrictions of iQ AppPortal.

Server specifications for using iQ AppPortal

The following shows the specifications of servers used for iQ AppPortal.

Version 1.23Z or earlier

Type

Connection method

Port number used”!

Others

VisualSVN Server 3.4.2

HTTP

TCP: 61687

HRoot directory
C:\Repositories\
HRepository name
iQAP

MService name”
VisualSVN Server

2

PostgreSQL 9.4.6

HTTP

TCP: 61689

- C
MService name™?

« postgresql-9.4 (32-bit version)
* postgresql-x64-9.4 (64-bit version)

iQ AppPortal

HTTP

TCP: 61688

EWService name 2

MELSOFT iQ AppPortal Service

*1  When installing iQ AppPortal in an environment where each product is already installed, the set port number is used.

*2  Runs as a service.

Point;§

Use VisualSVN Server Manager to change the port number of VisualSVN Server.
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Version 1.26C or later

Type Connection method | Port number used Others

76

VisualSVN Server 2 HTTPS TCP: 61687 MRoot directory

C:\Repositories\
HRepository name
iQAP

HLicense type
Community (free
BAuthentication mode
Subversion authentication™
ETLS/SSL compatibility level
Intermediate”™’
MWService name”
VisualSVN HTTP Service

\3v
)

5

PostgreSQL 9.4.6 HTTP TCP: 61689 MWService name”

5

« postgresql-9.4 (32-bit version)
* postgresql-x64-9.4 (64-bit version)

iQ AppPortal HTTP TCP: 61688 MService name™
MELSOFT iQ AppPortal Service
*1  When installing iQ AppPortal in an environment where each product is already installed, the set port number is used.
*2 Versions of VisualSVN Server used for each version of iQ AppPortal are as follows:
- iQ AppPortal Version 1.26C: VisualSVN Server 4.3.3
- iQ AppPortal Version 1.29F: VisualSVN Server 4.3.7
- iQ AppPortal Version 1.32J or later: VisualSVN Server 5.0.3
*3 If VisualSVN Server is not installed or VisualSVN Server (evaluation) is installed before installing iQ AppPortal, the license type and
authentication mode of VisualSVN Server are set as follows:
- License type: Community (free)
- Authentication mode: Subversion authentication
*4 When using a paid edition, iQ AppPortal can be used if the other specifications match.
*5 Runs as a service.
Point}@
Use VisualSVN Server Manager to change the setting such as the port number or certificate for VisualSVN
Server.
Restrictions

If VisualSVN Server is already installed before installing iQ AppPortal, specify the port number set for VisualSVN Server for

IIP

ort No." in the "Data Storage Destination/Work Area Setting" screen.
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Unusable character strings for iQ AppPortal

The following tables show the character strings that cannot be used for iQ AppPortal.

Precautions

The character strings are not case-sensitive.
A blank character (space) cannot be used before or after a character string; it is deleted.

Unusable character strings for a drive/path name

Category Character string

Invalid character (symbol) 1,*?," <,>1,, ; and a period at the end of a name

Reserved device name CON, AUX, COM1, COM2, COM3, COM4, COM5, COM6, COM7, COM8, COM9, LPT1, LPT2, LPT3, LPT4,
LPT5, LPT6, LPT7, LPT8, LPT9, PRN, NUL, CLOCK$

Reserved word for MELSOFT Navigator $_CPRJ_$

Unusable character strings for a folder name

Category Character string

Invalid character (symbol)*1 \VLL5 <>, %, ., & =, and a period at the end of a name

Reserved device name CON, AUX, COM1, COM2, COM3, COM4, COM5, COM6, COM7, COM8, COM9, LPT1, LPT2, LPT3, LPT4,
LPT5, LPT6, LPT7, LPT8, LPT9, PRN, NUL, CLOCK$

Reserved word for MELSOFT Navigator $ CPRJ_$

File name restriction by an operating system | Character codes 0x00 to 0x1f

*1 If used, iQ AppPortal may not run properly.
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Object configuration rules

When newly adding or updating a folder or object, the configuration of the object is displayed in the application tree area
according to the following relationships:

» Multiple objects can be placed in the same layer if their types are the same.

» An object cannot be placed in the lower layer of a target object if its type is the same as the target one.
« All objects other than those of MELSOFT products are placed in the second layer immediately under a folder.

Layer placement relationship of objects

QO: Placeable, X: Not placeable

Target Layer
1st layer 2nd layer 3rd layer 4th layer
Folder O X X X
Workspace file X @] X X
Project file X O O X
Other objects X O O @)
Parent-child relationship of objects
O: Placeable, X : Not placeable
Upper layer Lower layer
Folder Workspace file Project file Other objects
Folder X O O @)
Workspace file X X O @)
Project file X X X O
Other objects X X X X
APPX
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Folder format object

A folder format object is one of objects managed in iQ AppPortal. Files other than those of MELSOFT products can be
managed in a folder as one object.

Setting method of a folder format object

The following explains the method for registering a folder as a folder format object in iQ AppPortal.
To unify methods for registering a folder when multiple clients use one server, select the same item in the following setting

among the clients.

Window.

Select the [File] tab = [Option] = "Register."

Basic Setting
Folder Format Object Setting
Object 1
Maintain Folder Configuration and Register it as Folder Format Object(F) (1 )

Object 2 e

we ) Expand Folder and Register for Each File (Default)(Q) )
Register - -

This setting will be applied when registering to MELSOFT iQ AppPortal.

Verify The registered object is not affected by this setting.

The registered folder format object can be edited like the previous ones.
However, the files of MELSOFT product will be registered in object unit without applying
this cperation.

Restore Work Area

Please refer to the manual for the registration image of folder format object.

Display Manuals
oK | [ Cancel
Displayed.items
Item Description

(1) | Maintain Folder Configuration and Register it as
Folder Format Object

A folder is registered as a folder format object.

It is registered as one object with the configuration maintained.

(2) | Expand Folder and Register for Each File (Default)

A folder is expanded and each object is registered.

Operating procedure

For registering a folder as a folder format object, select (1) and click the [OK] button.
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Registration image

The following shows images when registering a folder.

(1): When selecting "Maintain Folder Configuration and Register it as Folder Format Object"
(2): When selecting "Expand Folder and Register for Each File"

EWhen registering only an object other than one of MELSOFT products

Project

Project
D note.txt
[ project.xml
[ project_A.pdf
[ Project_A.pptx
[ project_A.xlsx

APPX

*ih

Project
Date Modified:
2021701727

e
+

g project A.pdf
I Project AP
+

el Project Appix
+

- Axlsx
PR Project
+_

Work Area

gﬁ Project
E Project##
& Project
&) note.txt
&) project.xml
& ] project_A.pdf
& ] Project_A.pptx
@] project_A.xlsx
@ | Project.iqap
& ) Project.iqap
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Work Area

gﬁ Project

& | Projectit#
&) note.txt
& | note.txt.iqap
&) project.xml
& ] project.xml.igap
& ] project_A.pdf
@ project_A.pdf.igap
@ Project_A.pptx

@ Project_A.pptx.igap

@ project_A.xlsx

a project_A.xIsx.igap

& ] Project.iqap




4

Project

I\

Project
Date Modified

2021/01/27

| Project

= project_A
project_A.gx3
[ Project_A.pptx
[ project_A.xIsx

project B
[ Project_B.pptx
[ project_B.xIsx

[ note.txt

[ project.xml

Work Area

E Project

ﬁ Project##
E Project
E} project_A
& ] Project_A.pptx
@ project_A.xlsx
ﬁ project_B
&) Project_B.pptx
@ project_B.xlIsx
a note.txt
@] projectxml
a Project.igap
& project_A.gx3
@ project_A.gx3.iqap

HEWhen registering a folder that contains a project file of MELSOFT products

) x |l Get the Latest Data | Save | Cancel ?
~
ﬁ F?l Project
Project +
Date Modified: 4
2023/10/10 I
0 % project A
3
I
()
] g rotenc
+
I
()
0 projectml
™
ll
()
| el Project Apptx
+
(0
()
Iy project i
+—
I
()
0 ol Project Bpptx
+
I
()
| I Project Basx
]
0
e &
Work Area

Project
ﬁ Project##
note.txt
note.txt.iqap
project.xml
project.xml.iqap
Project_A.pptx
Project_A.pptx.igap
project_A.xlsx
project_A.xIsx.igap
Project_B.pptx
Project_B.pptx.igap
project_B.xIsx

) )} ) o) ) o)) ] o) )

project_B.xIsx.igap

@] Projectigap
% project_A.gx3

@ project_A.gx3.igap
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Number of objects that can be registered in one folder format object

Up to 200 objects can be registered in one folder format object.
Data included or not in this number is as follows:
» Object and MELSOFT iQ AppPortal information file (.igap): Included.

* Folder: Not included.

Precautions

The following table shows the considerations for operating and displaying a folder format object.

Operation and display

Consideration

Registration
(== Page 23 Registering an object)

« If there is any read-only attribute folder, hidden folder, or hidden file in a folder registered as a folder format
object, it is registered as a normal folder or object.

* In addition, if there is any workspace file or project file of MELSOFT products in a folder registered as a folder
format object, it is expanded and registered in the same layer as the folder format object.

Status display of an object
(==~ Page 29 Status display of an object)

The status is displayed for each folder format object, not for each object in a folder format object. (Example: When
adding an object to a folder format object, the object status of the folder format object changes to 'change.")

Edit
(==~ Page 43 Editing an object)

When performing either of the following operations for a folder format object, the corresponding folder opens in
Windows Explorer.

 Double-click an object.

* Right-click an object and select [Open From Program] from the shortcut menu.

Import
(==~ Page 69 Importing objects)

If there is any workspace file or project file of MELSOFT products in a folder format object to be imported, it is
expanded in the same layer as the folder format object, registered in iQ AppPortal, and saved to a server.
It is displayed in each screen for import as follows:
* Import list in the "Import" screen:
Data in the folder format object is not displayed. If there is any workspace file or project file of MELSOFT
products in the folder format object, it is expanded and displayed in the same layer as the folder format object.
» Windows Explorer opened by right-clicking the folder format object in the import list in the "Import" screen and
selecting [Open the Place of Object] from the shortcut menu:
Data in the folder format object is displayed. If there is any workspace file or project file of MELSOFT products in
the folder format object, it is included and displayed in the folder of the folder format object.
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Read-only attribute folders

The following explains read-only attribute folders.

Read-only attribute folder types

When installing MELSOFT iQ AppPortal or FA Application Package iQ Monozukuri, the read-only attribute folder is

automatically registered.

Type

M & iQ Monozukuri Folder

M i ReadOnly Folder

Type

Description

ReadOnly Folder

Registered by selecting the checkbox of "Sample Workspace" when installing MELSOFT iQ AppPortal.

iQ Monozukuri Folder

Registered when installing FA Application Package iQ Monozukuri.

Point/©

When registering these folders by dragging and dropping from the installation DVDs or data downloaded for

installation, they are registered as normal folders.

Restrictions on a read-only attribute folder

The following table shows the restrictions on a read-only attribute folder.

Item Description
Register The read-only attribute folder is registered when installing an application. lts type and name are displayed.
Copy The history is also retained when copying a read-only attribute folder in iQ AppPortal.
However, it is not retained when copying a read-only attribute folder in a work area.
Paste When a copy source is a read-only attribute folder, an object in the folder is pasted to a paste destination.
When copying an object in the read-only attribute folder and pasting it to an empty area in the object list area, a new folder is
created in the same way as new registration.
The icon of the folder in the paste destination changes to the normal icon. (The type is a normal folder.)
Delete An object stored in a read-only attribute folder cannot be deleted.

Edit property information

For a read-only attribute folder, only the property information can be browsed.
Property information cannot be edited or saved in the "Properties" screen.

Display the status of an object

The object status is not displayed for a read-only attribute folder.

Acquire

When acquiring the latest data, specify a different area from a work area.

Classify

A classification cannot be added to an object in a read-only attribute folder.

Editing a read-only attribute folder

Read-only attribute folders do not exist in a work area, because the data is saved to a server only.
To edit a read-only attribute folder, the data must be acquired then re-registered in iQ AppPortal.
The following shows the procedure for re-registering a read-only attribute folder.

Operating procedure

1. Selecta read-only attribute folder, and click the [Get the Latest Data] button.

2. Specify a folder different from the work area.

3. Drag and drop the generated folder onto iQ AppPortal.

Point/@

When re-registering a read-only attribute folder, it is registered as a normal folder.
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Hiding read-only attribute folders

Read-only attribute folders cannot be reserved for deletion. Hide them as necessary.

File Home

[ycopy
ot wC
t i
M Delste Reservation La;;[ D:ta

@ Name - 0 [ Properties ﬁ( T2 Verify between Objects B8 Import e
| a1 CHistory ¥y Veerify with the Lat ata | B Export
Classification = 2% Z Refresh Release Hel
Edit Tile Display ~ Refine E:P

Sort Display Verify Data Operation

4 = U MELSOFT iQ AppPortal

File ' Home T
&% x ¢ . .
--------- 3 @C: Cannot execute delete reservation for the read-only attribute
1 L W fcider and the object.
el [} @ ! However, the read-only attribute folder can be hidden.
1 ! Please set with the following procedures from the option to hide
ServoSolution N... | ServoSolution_N... ! the read-only attribute folder.
Automated Guid... [ Rotary Knife(RD7... |
Date Modified: [ Date Modified: ) Procedure:
202170803 2021/00/03 1. Display the option setting by selecting [File] tab -> [Option].
| ! 2. Uncheck [Object] -> [Object Filtering] -> [Display the read-only
1 ! attribute folder].
v

They can be hidden in the option setting.

Window.

Select the [File] tab => [Option] = "Object 1."

2

Basic Setting = File ' Home
Object 1 [] Display the deleted object(s)

Object 2 (D Display the read-only attribute folder(R) )

Register The option at output

Verify [] Start the explorer at get the latest data(E)

Smart Filter
Restore Work Area Classification Option

poooooooooogy

isplay the name of classification added to object. (At the time of list displa
Display th F classifi dded to object. (At th f list display) (Q)
Callout Property Option

[ Enable Editing of Callout Property(V)

It s possible to edit the name, model name, outline, image, authar, and remark.

The display item other than the name can be selected.

Display Item(D): Item Name

Date Modified ~
V Model Name E
V) Outline
V| Feature

 Image

Cache Setting
@ Enable Cache(C)
© Disable Cache()

If cache setting is enabled, the screen can be displayed faster, But if enabled, the displayed
folder cannot be displayed in the latest state sometimes. The latest state can be displayed
by selecting the folder which the latest state want to be confirmed,

When refresh all the object cache, please execute "Cache Refresh™.

Cache Refresh
oK. Cancel

Operating procedure
Unselect the checkbox of "Display the read-only attribute folder" under "Object Filtering," and click the [OK] button.

EMaintaining the hidden state

Read-only attribute folders remain hidden even after uninstalling MELSOFT iQ AppPortal.

If read-only attribute folders are not displayed after reinstalling MELSOFT iQ AppPortal, select the checkbox of "Display the
read-only attribute folder" to display.
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Restrictions on GX Developer, RT ToolBox3, and RT ToolBox2
objects

The following restrictions apply to GX Developer, RT ToolBox3, and RT ToolBox2 objects in a workspace managed in
MELSOFT Navigator:

» Objects cannot be added to/changed in a workspace managed in MELSOFT Navigator.

» Objects cannot be deleted from a workspace managed in MELSOFT Navigator.

» Objects cannot be pasted to a workspace managed in MELSOFT Navigator.

» Objects cannot be moved to/from a workspace managed in MELSOFT Navigator.
In addition, if there are multiple objects with the same workspace name among GX Developer, RT ToolBox3, or RT ToolBox2

objects, the following restrictions apply:
» Objects cannot be updated by dragging and dropping or by copying and pasting between workspaces with the same name.

» Workspaces with the same name cannot be registered in the same layer.

Folder configuration in a work area

The following shows the folder configuration in a work area.

New Folder i New Folder## [ Sample.pdf
(2)/0 New Folder$$ [ Sample.pdf.iqap
\ (3) HH  GXW3 sample.gx3 [ Sample.txt
™ [1 GXW3 sample.gx3.igap [ Sample.txt.iqap
[ Navigator_sample.nvw
[ workspacelist.xml
[1 New Folder.igap [) ws000000.BMP
@0
Folder name/file name Stored file type Reference
1) (Folder name)"! A file that can be refined by the type under the smart filter Page 34 Objects that can be refined by the type
(2) (Folder name)##*1 Afile other than the above —
3) (Folder name)$$*1 An image added in the "Properties" screen Page 31 Image registration
(4) (Folder name).iqap*1 A MELSOFT iQ AppPortal information file (.iqap) Page 86 MELSOFT iQ AppPortal information file
(-iqap)

*1  For iQ AppPortal Version 1.01B or earlier, (New Folder (date and time)) is displayed for (folder name).

Folder name in a work area

For iQ AppPortal Version 1.04E or later, a folder name in a work area is the same as one created in iQ AppPortal.

EChanging a folder name or file name in a work area
Even when changing a folder name or file name in a work area directly in Windows Explorer, etc., the change is not applied to

the folder or object in iQ AppPortal.
A folder or file will no longer be managed in iQ AppPortal if its name is changed.

To manage it in iQ AppPortal, re-register it in iQ AppPortal.
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MELSOFT iQ AppPortal information file (.igap)

A MELSOFT iQ AppPortal information file (.igap) is a file with information on a folder and object (feature information of a
project, the icon of an application, etc.).

It is saved to a server and work area with a folder and object.

Output method of a MELSOFT iQ AppPortal information file (.iqap)

Whether to output a MELSOFT iQ AppPortal information file (.iqap) can be set in "Setting for MELSOFT iQ AppPortal" in each
MELSOFT product.
For the setting method of "Setting for MELSOFT iQ AppPortal," refer to the manual for each MELSOFT product.

Precautions

Do not change the name, configuration, or contents of a MELSOFT iQ AppPortal information file (.iqap).
If any of them is changed, the property information may not be displayed properly.

Point

For a MELSOFT iQ AppPortal information file (.igap) to which security such as access authority or a security
key is set, only "Security" is displayed in the feature information of iQ AppPortal to prevent information
leakage.

Versions of MELSOFT products used for verification

The following table shows the versions of MELSOFT products used for verification (==~ Page 64 Verification).

MELSOFT product Version

iQ AppPortal Ver.1.17T or later

GX Works3 Ver.1.025B or later

GX Works2 Ver.1.595V or later

GT Designer3 (GOT2000) Ver.1.235V or later
Point

For details on verification, refer to the following:

[T1GX Works3 Operating Manual

L[T1GX Works2 Version 1 Operating Manual (Common)
[TIGT Designer3 (GOT2000) Screen Design Manual
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Setting an external tool used for verification

The following explains the method for setting an external tool used to verify (==~ Page 64 Verification) objects other than
those of MELSOFT products.
An external tool refers to a tool other than a MELSOFT product.

The operation of WinMerge, which can compare folders and files, has been checked as an external tool used for verification.
Note that not all external tools are guaranteed to work with iQ AppPortal. Check the operation before use.

[Ex]

The following shows a setting example when using WinMerge.

Command: C:\Program Files\WinMerge\WinMergeU.exe

Argument: /wl /wr /dl %sname /dr %dname %src %dst

Window.

Select the [File] tab = [Option] = "Verify."

Basic Setting
Object 1
Object 2
Register
Verify

Restore Work Area

External Tool Setting

Command(M):

Argument{A):

Set the external tool used for verification of other file or folder format objects.
Please set the command,argument of external tool after referring to the manual.

| CA\Program Files\WinMerge\WinMergel.exe ‘ ||-"(1 )

I fwl fwr /dl %sname /dr Sedname %src %dst I m—-- (3)
I )

Disj Manuals

oK | [ cancel

Displayed.items

Item

Description

(1) Command

Enter the command (execution file path) of an external tool used for verification.
Up to 260 characters can be entered.

(2) | Argument

Enter a command argument defined in an external tool and a replacement parameter.

Up to 1024 characters can be entered.

Refer to the manual or help for the external tool as necessary.

« Replacement parameter

A replacement parameter is used to define an argument (the file path of a verification target, etc.), which requires a
different value for each verification operation, as a parameter. It is replaced with the corresponding value by iQ
AppPortal when verifying an object.

(3) | [»] button

Click this to reference replacement parameters.
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Operating procedure

1. Enter the command (execution file path) of an external tool used for verification for "Command."

2. Enter a command argument defined in the external tool for "Argument.”

Click the [P] button to select and enter a replacement parameter”.

3. Click the [OK] button.

*1 Each replacement parameter is replaced as follows when verifying an object.

Replacement parameter

Content replaced when verifying an object

Source object (%src)

Absolute paths to a folder and file of a verification source object.
* When verifying with the latest data: Path on a work area
* When setting an object selected in the object list area or application tree area as a verification source
in the "Verify between Objects" screen: Path on a work area
« Other cases: Paths to a folder and file of a verification source object output to a temporary area

Destination object (%dst)

» When setting an object selected in the object list area or application tree area as a verification
destination in the "Verify between Objects" screen: Path on a work area

« Other cases: Absolute paths to a folder and file of a verification destination object output to a
temporary area

Source object window display name (%sname)

A display name of a verification source object in the window of an external tool

Destination object window display name (%dname)

A display name of a verification destination object in the window of an external tool
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Appendix 3 Considerations

This section describes the considerations for iQ AppPortal.

When communication with iQ AppPortal is not allowed by
Windows Firewall

When Windows Firewall is enabled and communication with iQ AppPortal is not allowed, a timeout may occur.

To allow the communication on a personal computer on which a server is installed, configure the setting by the following
procedure.

When using other software with a firewall function, refer to the manual for the software and allow the communication with iQ
AppPortal.

-

. Select [System and Security] = [Windows Defender Firewall] = [Advanced settings] in the control panel of Windows.

N

Select [Inbound Rules] = [New Rule] in the "Windows Defender Firewall with Advanced Security" screen.

w

Select "Port" in [Steps:] = [Rule Type] in the "New Inbound Rule Wizard" screen.

A

Select "TCP" and "Specific local ports" in [Steps:] = [Protocol and Ports].

o

Enter '61688' in "Specific local ports," and click the [Next] button.

©

Select "Allow the connection" in [Steps:] = [Action], and check that all the checkboxes are selected in [Steps:] = [Profile].

N

Enter a name (example: MELSOFT iQ AppPortal) in "Name" and "Description" in [Steps:] = [Name], and click the
[Finish] button.

The name (example: MELSOFT iQ AppPortal) is added to the list of "Inbound Rules" in the "Windows Defender Firewall with
Advanced Security" screen.

Update from iQ AppPortal Version 1.00A

The configuration of a folder generated in a work area differs between iQ AppPortal Version 1.00A and iQ AppPortal Version
1.01B or later.
Therefore, when re-registering a folder generated in a work area by using iQ AppPortal Version 1.00A in iQ AppPortal Version

1.01B or later without changing the configuration, some data (files other than those of MELSOFT products, images added in
the "Properties" screen, etc.) is not displayed properly on iQ AppPortal.

To display it properly on iQ AppPortal Version 1.01B or later, change the folder configuration by either of the following
methods:

» When updating the folder configuration in a work area to a new one

Update it in iQ AppPortal Version 1.00A. The folder configuration is automatically updated to a new one.

» When changing the folder configuration outside a work area to a new one

Manually change it to the same folder configuration as that in the work area. (==~ Page 85 Folder configuration in a work
area)

Re-register it in iQ AppPortal Version 1.01B or later after changing to a new folder configuration.

Folders/files for system management

The following types of folders and files generated in a work area are for system management. Do not delete or move them.
* MELSOFT iQ AppPortal information file (.igap)

* VisualSVN Server folder (.svn)

+ iQAPData file (iQAPData)

Subversion function

Subversion is built into iQ AppPortal.
To maintain the consistency of managed data, do not use the Subversion function for folders and objects in a work area.

APPX
Appendix 3 Considerations 89



MEMO

APPX
90 Appendix 3 Considerations



Appendix 4 Troubleshooting

This section explains the errors which may occur when using iQ AppPortal and their corrective actions.

Symptom

Check point

Corrective action

Contents in the screen are not
displayed properly.

(For example, overlapping of icons,
text overflowing from the frame of a
button, etc.)

Is the size of the text and other items
in the screen set to a value other than
100% (96 DPI, 9 pt etc.) in Windows
settings?

* Set the value to 100% (96 DPI, 9 pt etc.).

* For Windows 10 (version 1703 or later) or later’, the display of iQ
AppPortal can be displayed with high DPI scaling by using a function of the
operating system.*2

@ Select and right-click 'IQAppPortaI.exe,"3 then select [Properties] from the

shortcut menu.

@ Click the [Change high DPI settings] button in the [Compatibility] tab.

© Select the checkbox of "Override high DPI scaling behavior. Scaling

performed by:," then select "System" from the pull-down list.

O Click the [OK] button.

Connection to a server fails when
using iQ AppPortal Version 1.23Z or
earlier.

« Is the connection method set to
'https' in the communication setting
for VisualSVN Server?

« Has iQ AppPortal Version 1.26C or
later ever been installed?

Change the connection method to 'http' in the communication setting for
VisualSVN Server.

*1 The Windows version can be checked by the following procedure:
@ Enter "winver" in the search box of Windows, and select it from the menu.
@ Check the version in the displayed screen.

*2

The display of iQ AppPortal will be blurred by enlarging.

The following lists the setting values for "Change the size of text, apps, and other items" and the recommended display resolution for
each setting value in Windows 10 or later.

Setting value: 100%, display resolution:
Setting value: 125%, display resolution:
Setting value: 150%, display resolution:
Setting value: 175%, display resolution:
Setting value: 200%, display resolution:
Setting value: 225%, display resolution:
Setting value: 250%, display resolution:
'IQAppPortal.exe' is stored in the folder where iQ AppPortal is installed.

*3

1024 x 768 dots or more

1900 x 1200 dots or more
1900 x 1200 dots or more
2880 x 1620 dots or more
2880 x 1620 dots or more
3840 x 2160 dots or more
3840 x 2160 dots or more

The following are examples of storage locations.

64-bit version operating system: C:\Program Files (x86)\MELSOFT\iQAP\Client\IQAppPortal.exe

32-bit version operating system: C:\Program Files\MELSOFT\iQAP\Client\IQAppPortal.exe
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Appendix & Open Source Software

This section describes open source software and its license utilized for this product.

Entity Framework 6.1.3

Copyright © Microsoft Open Technologies, Inc. All rights reserved.
For details, refer to "MELSOFT\iQAP\Server\licenses\EntityFramework" in the folder in which this product has been installed.

Mono.Security 4.0.0.0

Copyright © 2001, 2002, 2003 Ximian, Inc and the individuals listed on the ChangelLog entries.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the
Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software,
and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Npgsql 2.2.7, Npgsql for Entity Framework 2.2.7

Copyright © 2002-2016, The Npgsql Development Team

Permission to use, copy, modify, and distribute this software and its documentation for any purpose, without fee, and without a written agreement is hereby
granted, provided that the above copyright notice and this paragraph and the following two paragraphs appear in all copies.

IN NO EVENT SHALL THE NPGSQL DEVELOPMENT TEAM BE LIABLE TO ANY PARTY FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES, INCLUDING LOST PROFITS, ARISING OUT OF THE USE OF THIS SOFTWARE AND ITS DOCUMENTATION, EVEN IF
THE NPGSQL DEVELOPMENT TEAM HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

THE NPGSQL DEVELOPMENT TEAM SPECIFICALLY DISCLAIMS ANY WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE SOFTWARE PROVIDED HEREUNDER IS ON AN "AS IS" BASIS, AND THE
NPGSQL DEVELOPMENT TEAM HAS NO OBLIGATIONS TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR MODIFICATIONS.

PostgreSQL 9.4.6

PostgreSQL is Copyright © 1996-2016 by the PostgreSQL Global Development Group.

Postgres95 is Copyright © 1994-5 by the Regents of the University of California.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose, without fee, and without a written agreement is hereby
granted, provided that the above copyright notice and this paragraph and the following two paragraphs appear in all copies.

IN NO EVENT SHALL THE UNIVERSITY OF CALIFORNIA BE LIABLE TO ANY PARTY FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES, INCLUDING LOST PROFITS, ARISING OUT OF THE USE OF THIS SOFTWARE AND ITS DOCUMENTATION, EVEN IF
THE UNIVERSITY OF CALIFORNIA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

THE UNIVERSITY OF CALIFORNIA SPECIFICALLY DISCLAIMS ANY WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE SOFTWARE PROVIDED HEREUNDER IS ON AN "AS-IS" BASIS, AND THE
UNIVERSITY OF CALIFORNIA HAS NO OBLIGATIONS TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR MODIFICATIONS.
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SharpSvn 1.8

Copyright © 2007-2012 The SharpSvn Project
For details, refer to "MELSOFT\iQAP\Client\licenses\SharpSvn" in the folder in which this product has been installed.

VisualSVN Server 5.0.3

Copyright © 2022 VisualSVN Software Ltd. All rights reserved.

For details, refer to "VisualSVN Server\README.txt" in the installed folder.
For the license, visit the following:

Apache License Version 2.0: www.apache.org/licenses/LICENSE-2.0

zlib 1.2.8

/* zlib.h -- interface of the 'zlib' general purpose compression library version 1.2.8, April 28th, 2013
Copyright © 1995-2013 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this
software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the
following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an
acknowledgment in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly Mark Adler

jloup@gzip.org madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs (Request for Comments) 1950 to 1952 in the files http://tools.ietf.org/html/rfc1950 (zlib format),
rfc1951 (deflate format) and rfc1952 (gzip format).*/

MiniZip (included in zlib 1.2.8)

MiniZip - Copyright © 1998-2010 - by Gilles Vollant - version 1.1 64 bits from Mathias Svensson

License

Condition of use and distribution are the same than zlib :

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this
software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the
following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an
acknowledgment in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.
3. This notice may not be removed or altered from any source distribution.
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REVISIONS

*The manual number is given on the bottom left of the back cover.

Revision date

*Manual number

Description

April 2016

SH(NA)-081623ENG-A

First edition

June 2016

SH(NA)-081623ENG-B

BAdded or modified parts
RELEVANT MANUALS, Chapter 2, Section 3.4, Section 3.6, Chapter 4, Appendix 1, Appendix 2,
Appendix 3

March 2017

SH(NA)-081623ENG-C

BAdded or modified parts

Chapter 1, Section 1.2, Section 1.3, Chapter 2, Section 3.5, Section 3.6, Section 4.1, Section 4.2,
Section 4.3, Section 4.4, Section 4.5, Section 4.6, Appendix 1, Appendix 2

HDeleted part

Section 1.3

December 2017

SH(NA)-081623ENG-D
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Section 3.4, Section 3.6, Section 4.1, Section 4.2, Section 4.3, Section 4.4, Section 4.5, Section 4.7,
Appendix 1, Appendix 2, Appendix 4

April 2019

SH(NA)-081623ENG-E
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Section 3.3, Section 3.5, Section 4.1, Section 4.3, Section 4.6, Appendix 1

November 2019

SH(NA)-081623ENG-F

BAdded or modified parts
Section 4.6, Appendix 1

May 2020

SH(NA)-081623ENG-G

WAdded or modified parts
Section 3.4, Section 3.5, Section 3.6, Section 4.4, Section 4.7, Appendix 1, Appendix 2

November 2020

SH(NA)-081623ENG-H
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SAFETY PRECAUTIONS, CONDITIONS OF USE FOR THE PRODUCT, Section 4.6, Section 4.7,
Appendix 1

April 2021

SH(NA)-081623ENG-|

BAdded or modified parts
Section 1.3, Section 3.4, Section 4.1, Section 4.3, Section 4.4, Section 4.5, Section 4.7, Section 4.8,
Appendix 1, Appendix 2

October 2021

SH(NA)-081623ENG-J

BAdded or modified parts
Section 3.3, Section 3.6, Section 4.7, Appendix 1, Appendix 2, Appendix 4, Appendix 5

April 2022

SH(NA)-081623ENG-K

BAdded or modified parts
Section 3.3, Section 3.5, Section 3.6, Appendix 1, Appendix 2, Appendix 4, Appendix 5

December 2022

SH(NA)-081623ENG-L

BAdded or modified parts
SAFETY PRECAUTIONS, Section 1.2, Section 3.3, Section 3.4, Section 3.5, Section 3.6, Section
4.2, Section 4.6, Section 4.7, Appendix 1, Appendix 2, Appendix 4, Appendix 5

November 2023

SH(NA)-081623ENG-M
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Section 1.3, Section 3.4, Section 3.5, Section 4.2, Section 4.3, Section 4.4, Section 4.5, Appendix 1,
Appendix 2

Japanese manual number: SH-081622-M

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent licenses. Mitsubishi Electric Corporation cannot
be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.

© 2016 MITSUBISHI ELECTRIC CORPORATION
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INFORMATION AND SERVICES

For further information and services, please contact your local Mitsubishi Electric sales office or representative.
Visit our website to find our locations worldwide.

MITSUBISHI ELECTRIC Factory Automation Global Website
Locations Worldwide
www.MitsubishiElectric.com/fa/about-us/overseas/

TRADEMARKS

Microsoft and Windows are trademarks of the Microsoft group of companies.

Subversion is either a registered trademark or a trademark of the Apache Software Foundation in the United States and/or
other countries.

The company names, system names and product names mentioned in this manual are either registered trademarks or
trademarks of their respective companies.

In some cases, trademark symbols such as ™" or '®"

COPYRIGHTS

are not specified in this manual.

The screens (screenshots) are used in accordance with the Microsoft Corporation guideline.
For the open source software used in this product, refer to the following:
[=5~ Page 93 Open Source Software
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